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C H A P T E R  1  

Install and Set Up 

1.1  Start Dolphin ScreenReader 

Dolphin ScreenReader will start automatically after you log onto your 

computer unless you have stated otherwise during the installation process. 

You can manually start Dolphin ScreenReader after log on by using the 

Dolphin ScreenReader shortcut key. 

Press CONTROL + SHIFT + S. 

If you have installed a new version alongside your existing version then the 

new version will be automatically given the following shortcut key: 

Press CONTROL + SHIFT + D. 

You can also launch Dolphin ScreenReader by selecting the Dolphin 

ScreenReader shortcut in the Windows Start menu. This is in the Programs, 

Dolphin sub-menu. 
  

1.2  Run Dolphin ScreenReader for the first time 

You will be guided through the activation process the first time you run 

Dolphin ScreenReader after installation. 

The activation process will guide you through unlocking and activating your 

software. 
  

1.3  Learn your hot keys 

You can use the Dolphin ScreenReader Key Describer to help you get 

familiar with your keyboard layout and Dolphin ScreenReader hot keys.  
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An application will not see or act on any keys pressed when you use Key 

Describer. 

To turn on or off "Key Describer": 

Key Describer Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Turn on or off Key Describer CAPS LOCK + 

SLASH 

CAPS LOCK + 

1 

 
  

1.4  Quit Dolphin ScreenReader 

To quit Dolphin ScreenReader: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + F. This will open the "File" menu. 

3. DOWN ARROW to "Quit Dolphin ScreenReader" and press ENTER. A 

message window will appear asking you to confirm you want to quit. 

4. TAB to the "Yes" button and press SPACEBAR. 

 



 

 7 

 

C H A P T E R  2  

How to find help 

2.1  Use the quick reference booklet 

A quick reference booklet is included in the box containing your Dolphin 

ScreenReader software. This book contains information on getting started 

with Dolphin ScreenReader, covering the popular hot keys you use with 

this software. 
  

2.2  Hotkey Helper 

Dolphin ScreenReader contains a large number of hot keys for accessing 

useful features or product settings via a quick simple keypress. Dolphin 

ScreenReader's Hotkey Helper function helps you find the correct hot key 

combination for a specific feature or product setting when you can't 

remember what the hot key is.  

For example, if you have a speech edition of Dolphin ScreenReader, you 

may want to find the hot key combination for announcing the contents of 

Excel's formula bar aloud. So instead of opening the Dolphin 

ScreenReader application-specific help file for Excel and reading through 

all of the available hot keys, or entering Dolphin ScreenReader's Key 

Describe Mode, CAPS LOCK + FORWARD SLASH, and then pressing 

various key combinations until you find the correct hot key, you can instead 

open Dolphin ScreenReader's Hotkey Helper window, by pressing LEFT 

SHIFT + CAPS LOCK + F2, or by selecting the "Hotkey Helper" menu item 

from Dolphin ScreenReader's CAPS LOCK + F1 help menu, and typing the 

word formula in the search edit box in the Hotkey Helper HTML window in 

order to view a list of all of the hot keys related to working with formulas. 

If you start a Hotkey Helper search with the ^ symbol (SHIFT+6 on your 

keyboard, and sometimes referred to as a freestanding circumflex, or hat, 

or up arrow symbol), Dolphin ScreenReader's Hotkey Helper will search 



 

8 How to find help 

 

application names rather than hot key descriptions. So the search phrase 

^acrobat will list all of the available hot keys in Adobe Reader. 

You can use Dolphin ScreenReader's standard web browsing keys 

to review the contents of your search in Dolphin ScreenReader's 

Hotkey Helper HTML window. 

 
  

2.3  Get help using an application 

Dolphin ScreenReader includes help on how to use many popular 

applications. 

Help includes: 

 How to configure the application for best performance. 

 How to complete many common tasks using only the keyboard. 

 A list of popular hot keys. 

While Dolphin ScreenReader is running, you can open the Dolphin 

ScreenReader Help from within your application. When you open the 

Dolphin ScreenReader Help menu, the first item will link to specific 

information about using Dolphin ScreenReader with the current application. 

To do this: 

1. Press CAPS LOCK + F1. 

A context menu opens. 

2. DOWN ARROW to select the name of your application. For example, 

Microsoft Word 2007 and then press ENTER. 

Dolphin ScreenReader opens an HTML Help window, which 

contains  the help content. 
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When you wish to return to your application, you can press ALT + F4 to 

close the Help window. 
  

2.3.1  Move within Help topics 

You can use Arrow Keys to move around within topics. In addition, you can 

use the following web page navigation commands to move around within 

help topics. Visit the Internet Explorer section of the Dolphin ScreenReader 

manual for a complete list of hot keys for moving around web pages. 

 Move to the next heading, H. 

 Move to the previous heading, SHIFT + H. 

 Move to the next link, TAB. 

 Move to the previous link, SHIFT + TAB. 

 Move to the bottom of the current document, CONTROL + END. 

 Move to the top of the current document, CONTROL + HOME. 

 Read from here to the end of the document, press the Read From 

Here hot key. 

Read From Here 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Start Read From Here NUMPAD 

PLUS 

CAPS LOCK + 

DOWN 

ARROW 

Stop Read From Here NUMPAD 

PLUS 

or ESCAPE 

or LEFT 

CONTROL 

SPACEBAR 

or ESCAPE 

or CONTROL 
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When you wish to return to your application, you can press ALT + F4 to 

close the Help window. 
  

2.3.2  Move between Help topics 

You can use the links at the top of each topic to go to the next or previous 

topic. 

To do this: 

1. Press CONTROL + HOME to move to the top of the document. 

2. Press TAB to move by link until you hear "Previous Topic Link" or "Next 

Topic Link". You can press SHIFT + TAB to move back to any links you 

may have skipped. 

3. Follow the link you have chosen by pressing ENTER. 

You can use the "Home" link to move to a page containing links to all topics 

relating to the current application. 

When you wish to return to your application, you can press ALT + F4 to 

close the Help window. 
  

2.3.3  Switch between Help and your application 

You can remember your place in the Dolphin ScreenReader Help by 

keeping the Dolphin ScreenReader Help Browser window open. You may 

find it useful to switch between the Dolphin ScreenReader Help Browser 

window and your application window several times while carrying out help 

instructions. 

To do this: 

1. From the Dolphin ScreenReader Help window, press ALT + TAB to 

switch back to your application. 

2. Carry out any actions in your application. 
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3. Press ALT + TAB to return to your position in the Help window. 

When you have finished using Dolphin ScreenReader help, you can press 

ALT + F4 to close the Help window. 
  

2.3.4  Add personal notes 

You can add personal notes in the Dolphin ScreenReader Help. You might 

do this to keep a note of certain hot keys or steps you need to follow to 

complete a task in an application. 

To do this: 

1. Run your application. 

2. Press CAPS LOCK + F1. 

The Dolphin ScreenReader Help menu opens. 

3. DOWN ARROW to “My Notes” and press ENTER. 

A blank document in NotePad or equivalent text editor opens. 

4. Add your text to the file. 

5. Save and close the file. 

You can review and add to your notes by selecting the “My Notes” item in 

the Dolphin ScreenReader Help menu. The text files you create are saved 

in your ¥Settings folder. 
  

2.4  Get Help from the Dolphin ScreenReader Control Panel 

Your Dolphin ScreenReader Control Panel provides two ways of getting 

help. 

 The Help button. 

 The Help menu. 
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2.4.1  Use the Help Button 

The Help button in the Dolphin ScreenReader Control Panel is context 

sensitive.  When you press this button, Dolphin ScreenReader opens the 

relevant section of the manual containing an explanation of the Dolphin 

ScreenReader settings in view. 

If the Dolphin ScreenReader Control Panel is not open, you can open it 

using LEFT CONTROL + SPACEBAR. 

You can press the Help button in any of these ways: 

 Left clicking the "Help" button on the Control Panel with the mouse. 

 TAB to the "Help" button and press SPACEBAR. 

 Press F1. 
  

2.4.2  Explore the Help menu 

The Help menu provides access to the complete Dolphin ScreenReader 

manual. The complete manual is particularly useful when you need to 

lookup a particular piece of information. 

1. If the Dolphin ScreenReader control panel is not open, you can open it 

using LEFT CONTROL + SPACEBAR. 

2. When in the Dolphin ScreenReader control panel, press ALT + H to 

open the "Help" menu. The first item in the menu is "Dolphin 

ScreenReader Manual". 

3. Press ENTER to open the Dolphin ScreenReader manual. 

Use the following keys to navigate the Dolphin ScreenReader manual: 

 Choose a section, UP and DOWN ARROW Keys. 

 Expand and collapse individual sections, RIGHT and LEFT ARROW 

Keys. 
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 Open a topic, ENTER. 

 Move between the contents and the open topic, F6. 
  

2.5  Get support for Dolphin ScreenReader 

2.5.1  Find help on the Dolphin website 

The Dolphin website offers a comprehensive range of support materials to 

help you get the most out of your Dolphin product. A variety of 

documentation is available, from handy tips and tutorials, to more technical 

knowledge base articles offering solutions to less common problems.  

To do this: 

1. Open a web browser and visit http://www.YourDolphin.com. 

2. Choose the "Support" link from the main navigation menu. 

3. Choose one of the options available to you: 

 Manuals and user guides. Dolphin's training Manuals and Quick Start 

Guides will help you get to grips with our products quickly and easily. 

 Tips & Tutorials. Handy step by step online tutorials covering the main 

product features. 

 Knowledge Base. The Knowledge Base is a searchable database 

containing a wealth of information and solutions to issues you might 

have with your Dolphin product. 
  

2.5.2  Contact your Dolphin Dealer for support 

If you purchased your Dolphin software from a registered Dolphin dealer, 

you can contact the dealer directly to receive the most appropriate localised 

support. If you do not know the contact details for your dealer, you can 

obtain these from the Dolphin website. 

To do this: 
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1. Open a web browser and visit http://www.YourDolphin.com. 

2. Choose the "Dealers" link from the main navigation menu. This will 

open the "Dealer Locator" page. 

3. Select your country from the list then choose the "Submit" button. This 

will open a page displaying a list of Dolphin Dealers for that country. 

4. Review the results to locate the contact details for the dealer from which 

you purchased your Dolphin product. 
  

2.5.3  Contact Dolphin UK Product Support 

At Dolphin we pride ourselves in the quality and level of Product Support 

we provide to all our customers. Our goal is to continue to provide Product 

Support that is second to none. You can contact our Product Support team 

in a number of ways. 

To do this: 

 By telephone: +44 (0)1905 754765. 

 By telephone (UK Local Rate): 0345 130 5454. 

 By Fax: +44 (0) 1905 754 559. 

 By Email: support@yourdolphin.com. 
  

2.5.4  Contact Dolphin USA Product Support 

At Dolphin we pride ourselves in the quality and level of Product Support 

we provide to all our customers. Our goal is to continue to provide Product 

Support that is second to none. You can contact our Product Support team 

in a number of ways. 

To do this: 

 By telephone (Toll free): 888 519 4694 

 By telephone (International): +1 609 803 2173. 
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 By Email: support@dolphinusa.com. 
  

2.5.5  Find your product version number and your product serial 
number 

In the Dolphin ScreenReader "About" dialog box you can find information 

about: 

 Your Dolphin ScreenReader version number. 

 Your personal Dolphin ScreenReader serial number. 

 A copy of the Dolphin ScreenReader software license agreement. 

To open this dialog box: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + H. This will open the "Help" menu. 

3. DOWN ARROW to "About" and press ENTER. This will open the 

"About" dialog box. 
  

2.5.6  Get further product training 

Dolphin has a network of approved trainers who are available to offer you 

high quality training either within your home or in your place of work. Our 

trainers can personalise the training to your individual requirements 

allowing you to maximise your independence, whilst taking into account 

your level of technical knowledge. You can contact Dolphin to find a 

Dolphin approved trainer in your area. 

To do this: 

 By telephone: +44 (0)1905 754577. 

 By Email: info@dolphinuk.co.uk. 
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C H A P T E R  3  

Dolphin ScreenReader Control Panel 

3.1  |Introducing the Dolphin ScreenReader Control Panel 

 
  

The Dolphin ScreenReader Control Panel is the place that contains all of 

the settings for Dolphin ScreenReader. 

You can find Dolphin ScreenReader's settings in the Control Panel's menu 

bar and the button bar. 

The menu bar, which is the horizontal bar positioned below the title bar 

containing options to drop down menus, provides access to all the settings 

available in Dolphin ScreenReader. The button bar, which is positioned 

below the menu bar and contains large easy to access buttons, provides 

access to Dolphin ScreenReader's most commonly used settings. 

The final part of the Dolphin ScreenReader Control Panel is the status bar. 

The status bar, which is the horizontal bar at the bottom of the Dolphin 

ScreenReader Control Panel, provides information about the Settings files 

you are using. 
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You can switch from a full-sized to a compact version of the control panel 

using the restore down and maximise buttons in the title bar of the control 

panel. 
  

 
  

3.2  Keyboard commands to get around the Dolphin 
ScreenReader Control Panel 

The following tables provide a list of keyboard commands to help you get 

around the Dolphin ScreenReader Control Panel. Note that these keyboard 

commands are also standard Windows commands that you can use 

throughout Windows. 

Keyboard Commands for the menu bar. 

Function Hot key 

Move focus to the menu bar ALT 

Move focus across the menu bar LEFT ARROW or 

RIGHT ARROW 

Open the menu item that has 

focus 

DOWN ARROW or 

ENTER 

Move to and open a menu bar 

item 

ALT + Underlined letter 

Move through an open menu DOWN ARROW or UP 

ARROW 

Open a submenu RIGHT ARROW or 

ENTER 

Close a submenu LEFT ARROW or 

ESCAPE 

Select a menu item ENTER 
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Keyboard Commands for dialog boxes 

Function Hot key 

Move to the next control TAB 

Move to the previous control SHIFT + TAB 

Press a button, toggle a check 

box or select an option 

SPACEBAR 

Move directly to a control ALT + Underlined letter 

Open the next tab in a multi tab 

dialog box 

CONTROL + TAB 

Open the previous tab in a multi 

tab dialog box 

CONTROL + SHIFT + 

TAB 

Cancel ESCAPE 

 
  

3.3  Settings in the Dolphin ScreenReader Control Panel 

All the Dolphin ScreenReader options can be accessed through the menus 

in the Dolphin ScreenReader Control Panel.  The following list 

summarises the purpose of the menus. 

 File menu: 

The "File" menu contains options for selecting your user profile as 

well as managing your Dolphin ScreenReader Settings files. This 

includes creating, editing, importing and exporting settings files. 

The "File" menu also contains the command to quit Dolphin 

ScreenReader. 
  

 Visual menu. 

The "Visual" menu contains options for adjusting the Dolphin 

ScreenReader Highlighting settings. The Highlighting settings are 

the visual marks Dolphin ScreenReader uses to indicate the focus 

position on the screen. 
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 Speech menu. 

The "Speech" menu contains the options to control what Dolphin 

ScreenReader announces. This includes voice settings like the 

speed and volume of the voice, plus options controlling what 

Dolphin ScreenReader says when you are typing, reading and 

working with text. 
  

 Braille menu. 

The "Braille" menu contains options to control what is output to a 

Braille display. This includes the Braille table, language and text 

attributes. 
  

 Media menu. 

The "Media" menu contains options for scanning, searching for 

books, reading online news articles, listening to radio stations and 

playing podcasts. 
  

 General menu. 

The "General" menu contains options that control Dolphin 

ScreenReader's behaviour including startup preferences, update 

settings, Control Panel appearance and Dolphin ScreenReader 

keyboard and hot key assignments. 
  

 Help menu. 

The "Help" menu provides shortcuts to useful resources including 

the Dolphin ScreenReader Manual, online resources and the 

"About" option. The "About" option provides you with your 

customer ID number plus the edition, version and build of Dolphin 

ScreenReader you are currently running. Ensure you have this 

information at hand if you require technical assistance. 
  

3.4  Change the appearance of the Dolphin ScreenReader 
Control Panel 

You can make many changes to the Dolphin ScreenReader Control Panel. 

For example, you can hide the button bar, hide the status bar, stop the 
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Control Panel appearing when you run Dolphin ScreenReader and remove 

it from the Windows Taskbar. 

For information about changing the Dolphin ScreenReader Control Panel, 

see the "General Control Panel dialog box". 
  

You can open the Dolphin ScreenReader Control Panel in several ways.  

Use the one which suits you best. 

To open the Dolphin ScreenReader main Control Panel: 

Press LEFT CONTROL + SPACEBAR. 

This opens the full Control Panel as a dialog box. 

Alternatively, using the mouse, to open the Dolphin ScreenReader Control 

Panel: 

Click the Dolphin ScreenReader icon in the Windows Notification 

Area. 

To open the Dolphin ScreenReader Control Panel as a simple menu: 

Press CAPS LOCK + SPACEBAR or RIGHT CLICK the Dolphin 

ScreenReader icon in the Windows Notification Area. 
  

3.5  Close the Dolphin ScreenReader control panel 

You can close the Dolphin ScreenReader Control Panel in several ways. 

To do this: 

Press ESCAPE. 

Or, 

Click the minimise icon in the Dolphin ScreenReader Control Panel 

title bar. 
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When you do this, the Dolphin ScreenReader Control Panel disappears 

and the focus goes back to the application you were previously running. 

Dolphin ScreenReader continues to run. 

NOTE: If you press ALT + F4 or click the close button in the Dolphin 

ScreenReader Control Panel title bar, then Dolphin ScreenReader 

will assume you want to quit the program. Before quitting, a 

message window appears asking you to confirm the action. 
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C H A P T E R  4  

Voice settings 

4.1  Turn the voice off or on 

 

You can turn off or on the voice using the "Speech" options in the Dolphin 

ScreenReader control panel or by using hot keys. 

To turn off the voice until you turn on the voice again: 

Speech Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Turn voice on and off LEFT 

CONTROL + 0 

LEFT 

CONTROL + 

ALT + 0 

Mute voice LEFT 

CONTROL 

CONTROL 
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4.2  Change volume 

 

You can change the volume of the voice using the "Speech" options in the 

Dolphin ScreenReader control panel or by using hot keys. 

Speech Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Increase volume LEFT 

CONTROL + 

EQUALS 

LEFT 

CONTROL + 

ALT + EQUALS 

Decrease volume LEFT 

CONTROL + 

MINUS 

LEFT 

CONTROL + 

ALT + MINUS 

 
  

4.3  Change reading speed 

 

You can change the reading speed of the voice using the "Speech" options 

in the Dolphin ScreenReader control panel or by using hot keys. 

Speech Hot Keys 
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Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Increase reading speed LEFT 

CONTROL + 

LEFT SHIFT + 

EQUALS 

LEFT 

CONTROL + 

ALT + PAGE 

UP 

Reduce reading speed LEFT 

CONTROL + 

LEFT SHIFT + 

MINUS 

LEFT 

CONTROL + 

ALT + PAGE 

DOWN 

 
  

4.3.1  Change voice 

 

Speech synthesisers often come with different voices to choose from. Each 

voice will have its own intonation, created within the speech parameters 

available. 

To change voice: 

1. Press LEFT CONTROL + SPACEBAR. 

The Dolphin ScreenReader control panel opens. 

2. Press ALT + S. 

The "Speech" menu opens. 

3. DOWN ARROW to "Voice Preferences" and press ENTER. 

The "Voice Preferences" dialog box opens. 

4. CONTROL + TAB until you open the "Voice and Language 

Configuration" page. 

5. TAB to the "Voice" list and use the Arrow Keys to select a voice. 
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6. If you want to have different voices for different speech contexts, TAB to 

the "Same as Screen Reader" check box and press SPACEBAR to 

deselect this option. Then, TAB to each category and use the Arrow 

Keys to select a voice. 

Note: A speech context is a special attribute of the text to be 

spoken which indicates where it came from or what Dolphin 

ScreenReader feature you are using. 

7. TAB to the "OK" button and press SPACEBAR. 

Dolphin ScreenReader saves the changes and closes the dialog 

box. 

If you are unable to find a voice you find comfortable to listen to then try 

another synthesiser or try creating your own voice using the options in the 

"User Defined Voices" page in the "Voice Preferences" dialog box. 
  

4.4  Change reading voice language 

 

Dolphin ScreenReader can automatically change the synthesiser language 

to match particular alphabetic scripts to make screen reading a more fluent 

experience. You can automatically switch between many scripts including 

Latin, Arabic, Chinese (Mandarin), Greek, Hebrew, Hindi (Devanagari) and 

Russian (Cyrillic). 

Where Dolphin ScreenReader is unable to determine the script language, 

for instance, where the same alphabet is used by different languages, you 

can use a hot key to select the synthesiser language you want to use to 

read the passage of text. 

Note that not all synthesisers support this feature. To learn more about 

supported synthesisers and available synthesiser languages please contact 

Dolphin or your local Dolphin dealer. 
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4.4.1  Enable automatic language switching 

1. Press LEFT CONTROL + SPACEBAR. 

The Dolphin ScreenReader control panel opens. 

2. Press ALT + S. 

The "Speech" menu opens. 

3. DOWN ARROW to "Voice Preferences" and press ENTER. 

The "Voice Preferences" dialog box opens. 

4. CONTROL + TAB until you open the "Voice & Language" page. 

5. TAB to the "Enable automatic language switching" check box and press 

SPACEBAR to select this option. 

6. If you want to prevent the speech changing when punctuation and 

numbers are encountered through passages of text, TAB to the "Speak 

numbers & punctuation with previous character's language" check box 

and press SPACEBAR to select this option. 

7. TAB to the "OK" button and press SPACEBAR. 

Dolphin ScreenReader saves the changes and closes the dialog 

box. 
  

If you are using a non-European version of Dolphin ScreenReader and 

require text to be automatically read using a European language, then, in 

addition to the steps above, in the "Voice & Lnaguage" page, de-select the 

“Same as screen reader” check box and select the European language you 

want to use from the “Screen language” list. 

You can also change the "Screen language" option by using the Language 

Up or Language Down hot key. This allows you to change synthesiser 

language without the need to leave the document you are reading. 
  

Speech Hot Keys 
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Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Language Down LEFT 

CONTROL + 

FULL STOP 

No Assignment 

Language Up LEFT 

CONTROL + 

COMMA 

No Assignment 

 
  

4.5  Change speech synthesiser 

Dolphin ScreenReader works with many different speech synthesisers. 

Supporting such a variety of speech synthesisers means you can pick a 

synthesiser and voice that you find comfortable, clear and responsive to 

use. To see what speech synthesisers are available please visit the 

Dolphin website or contact your local Dolphin Dealer. 

To change to another speech synthesiser: 

1. Press LEFT CONTROL + SPACEBAR. 

The Dolphin ScreenReader control panel opens. 

2. Press ALT + S. 

The "Speech" menu opens. 

3. DOWN ARROW to "Voice Preferences" and press ENTER. 

The "Voice Preferences" dialog box opens. 

4. CONTROL + TAB until you open the "Synthesiser Configuration" page. 

5. TAB to the "Select Synthesiser" button and press SPACEBAR. 

The "Select Synthesiser" dialog box opens. 

6. Use the Arrow Keys to select an alternative speech synthesiser. 
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7. TAB to the "OK" button and press SPACEBAR. 

Dolphin ScreenReader closes the dialog box and speaks using 

the new synthesiser.  

If you find the voice not to your liking then you can move into the 

"Voice and Language Configuration" page to choose a different 

voice. You could also move to the "User defined voices" page to 

customise the parameters of the existing voice. 

8. TAB to the "OK" button and press SPACEBAR. 

Dolphin ScreenReader closes the "Voice Preferences" dialog box. 
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C H A P T E R  5  

Reading and typing 

5.1  Read character 

Speak Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Read character at the 

current focus position 

NUMPAD 4 CAPS + LEFT 

ARROW 

 

 

You can learn more about the current character by repeating the press of 

the hot key. 

 x2 announces the phonetic character description. 

 x3 announces the character's attributes including font name, size and 

style. 

 x4 announces the unicode value of the character. 
  

5.2  Read word 

Speak Key 
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Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Read word at the current 

focus position 

NUMPAD 5 CAPS LOCK + 

RIGHT 

ARROW 

 

 

You can learn more about the current word by repeating the press of the 

hot key. 

 x2 spells the word. 

 x3 spells the word using the phonetic alphabet. 
  

5.3  Read line, read line to cursor and read line from cursor 

You can read the current line, read up to the cursor position on the current 

line and read from the cursor position on the current line. 

Speak Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Read line at the current 

focus position 

NUMPAD 6 No 

Assignment 

Read up to the cursor 

position on the current line 

LEFT SHIFT + 

NUMPAD 1 

CAPS LOCK + 

HOME 

Read from the cursor 

position on the current line 

LEFT SHIFT + 

NUMPAD 2 

CAPS LOCK + 

END 
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You can learn more about the current line by repeating the press of the hot 

key. 

 x2 reads the line including announcements of capital letters and 

spaces. 

 x3 spells the line. 
  

5.4  Read selected text 

You can read the text you have selected in your document with a hot key. 

Speak Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Read selected text NUMPAD 1 CAPS LOCK + 

SHIFT + 

DOWN 

ARROW 

 

 

You can learn more about the current selection by repeating the press of 

the hot key. 

 x2 spells the selected text including announcements of capital letters 

and spaces. 

 x3 spells the selected text using the phonetic alphabet. 
  

5.5  Read focus 

Speak Key 
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Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Read current focus NUMPAD 0 CAPS LOCK + 

UP ARROW 

 

 

You can learn more about the current focus by repeating the press of the 

hot key. 

 x2 spells the focus including announcements of capital letters and 

spaces. 

 x3 spells the focus using the phonetic alphabet. 
  

5.6  Read control 

Speak Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Read control NUMPAD 

PERIOD 

No 

Assignment 

 
  

You can learn more about the current control by repeating the press of the 

hot key. 

 x2 reads the control including announcements of capital letters and 

spaces. 

 x3 spells the control using the phonetic alphabet. 
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5.7  Read window 

Speak Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Read WINDOW NUMPAD 9 CAPS LOCK + 

B 

 
  

You can learn more about the current window by repeating the press of the 

hot key. 

 x2 spells the focus including announcements of capital letters and 

spaces. 
  

5.8  Read status 

Speak Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Read status information 

(e.g. status bar) 

NUMPAD 2 CAPS LOCK + 

PAGE DOWN 

 

 

You can learn more about the current status by repeating the press of the 

hot key. 

 x2 spells the status including announcements of capital letters and 

spaces. 

 x3 spells the status using the phonetic alphabet. 
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You may have additional commands added to this hot key for different 

applications. Please refer to the help for the application to learn more. 
  

5.9  Read shortcut key 

Speak Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Describe shortcut key LEFT SHIFT + 

NUMPAD 

PERIOD 

CONTROL + 

CAPS LOCK + 

LEFT ARROW 

 

 

You can learn more about the current shortcut key by repeating the press 

of the hot key. 

 x2 spells the shortcut key using the phonetic alphabet. 
  

5.10  Read date and time 

You can announce the current time and date with a Dolphin ScreenReader 

hot key. The time and date comes from your computer clock. 

Speak Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Read time and date LEFT 

CONTROL + 

LEFT SHIFT + 

NUMPAD 

SLASH 

CAPS LOCK + 

F12 
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5.11  Check where you are 

You can learn where you are by pressing the "Where Am I" hot key. 

Pressing The hot key gives different information depending on your current 

location.  

Examples: 

 The "Where Am I?" hot key tells you the window title, document name 

and current line in a word processor. 

 The "Where Am I?" hot key tells you the window title, property sheet 

name, group name and the name of the current control in a dialog 

box. 

Speak Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Where Am I? NUMPAD 7 CAPS LOCK + 

PAGE UP 

 
  

5.12  Read continuously 

Read From Here is a special reading mode available in Dolphin 

ScreenReader. 

You can use Read From Here to continuously read a document. Reading 

will continue until the end of the document or until you press a hot key to 

stop the reading. The pressing of a hot key to stop Dolphin ScreenReader 

reading will move the cursor to the last word spoken. 

You can change the speed of the voice during Read From Here and 

navigate backwards and forwards through the content of a document as it's 
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being spoken. Note that this requires the document area being read to 

support Dolphin Cursor navigation by unit in order to move by line, 

sentence, paragraph and heading, etc. Examples of supported document 

areas include Microsoft Word documents and Microsoft Outlook e-mails. 

Read From Here 

Function 
Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Start Read From Here NUMPAD 

PLUS 

CAPS LOCK + 

DOWN 

ARROW 

Pause/Unpause Reading SPACEBAR SPACEBAR 

Stop Reading NUMPAD 

PLUS 

or ESCAPE 

or LEFT 

CONTROL 

or RIGHT 

CONTROL 

ESCAPE 

or LEFT 

CONTROL 

or RIGHT 

CONTROL 

Stop Reading and switch 

focus 

LEFT SHIFT + 

SPACEBAR 

LEFT SHIFT + 

SPACEBAR 

Read From Here next line DOWN 

ARROW 

DOWN 

ARROW 

Read From Here previous 

line 

UP ARROW UP ARROW 

Read From Here next 

paragraph 

P P 

Read From Here previous 

paragraph 

LEFT SHIFT + 

P 

LEFT SHIFT + 

P 

Read From Here next 

sentence 

S S 

Read From Here previous 

sentence 

LEFT SHIFT + 

S 

LEFT SHIFT + 

S 
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5.12.1  Read From Here with the Dolphin Cursor 

Read From Here is also available when using the Dolphin Cursor. This 

allows you to continuously read information that you may not otherwise be 

able to read including web pages, dialog boxes, lists and menus. 

You can also turn on or turn off the Dolphin Cursor when you stop Read 

From Here. Turning on the Dolphin Cursor will place the Dolphin Cursor on 

the last word spoken. The application does not move focus to the new 

position.  

Read From Here 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Stop Read From Here and 

turn on or turn off the 

Dolphin Cursor 

NUMPAD 

MINUS 

SPACEBAR 

 
  

5.13  Change what is spoken when typing 

You can have: 

 Each character you type spoken. 

 Each word you type spoken. 

 Each character and word you type spoken. 

 Nothing spoken when typing. 

You can make this change through the Dolphin ScreenReader control 

panel. 

To do this: 
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1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + S. This will open the "Speech" menu. 

3. DOWN ARROW to "Character Echo" and press ENTER. This will open 

the "Character Echo" dialog box. 

4. Select what you want spoken when typing from the options available. 

5. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 

You can also change the Character Echo value using a Dolphin 

ScreenReader hot key. 

Speech hot key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Character echo cycle CAPS LOCK + 

SEMI COLON 

CAPS LOCK + 

2 

 
  

5.14  Announce capital letters 

You can announce capital letters by changing settings in the Dolphin 

ScreenReader control panel. Note that the Dolphin ScreenReader settings 

will vary depending on the synthesiser you are using. 
  

5.14.1  Turn on capital announcement 

You can turn on capital announcement by selecting the "Capitals" check 

box in the "Text Style Announcements" dialog box or by using a Dolphin 

ScreenReader hot key. 

To select the "Capitals" check box: 
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1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + S. This will open the "Speech" menu. 

3. DOWN ARROW to "Text Style Announcements" and press ENTER. 

This will open the "Text Style Announcements" dialog box. This is a 

dialog box with multiple tabs. 

4. If you want capital announcements in edit areas, in the "Edit Areas" tab, 

TAB to the "Capitals" check box and press SPACEBAR to select this 

item. 

5. If you want capital announcements in prompt areas like dialog boxes, 

message windows and worksheets, CONTROL + TAB to open the 

"Prompt Areas" tab, then TAB to the "Capitals" check box and press 

SPACEBAR to select this item. 

6. Repeat the previous steps for all other areas and modes where you 

want to have capital announcements. 

7. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 

To use the Dolphin ScreenReader hot key: 

Speech Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Capitals on / off CAPS LOCK + 

QUOTE 

No 

Assignment 

Note that this hot key changes the "Capitals" check box status in the "Text 

Style Announcements" dialog box corresponding to your current focus 

position. 

Examples: 



 

42 Reading and typing 

 

 Press the hot key in an edit area and only the status of the "Capitals" 

check box in the "Edit Areas" tab of the "Text Style Announcements" 

dialog box will change. 

 Press the hot key in a menu and only the status of the "Capitals" 

check box in the "Menus" tab of the "Text Style Announcements" 

dialog box will change. 
  

5.14.2  Turn on capital announcement when reading lines 

By default, if you turn on capital announcement in edit areas then Dolphin 

ScreenReader will announce capitals when you are typing and when you 

are moving across a line of text. To also announce capitals when you are 

reading a line, for example, when you press DOWN ARROW to move focus 

onto a new line, you must also select the "Announce capitals when reading 

lines" check box. 

To do this: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + S. This will open the "Speech" menu. 

3. DOWN ARROW to "General Announcements" and press ENTER. This 

will open the "General Announcements" dialog box. 

4. TAB to the "Announce capital letters when reading lines" check box and 

press SPACEBAR to select this item. 

5. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 
  

5.14.3  Using sounds to indicate capitals 

By default, Dolphin ScreenReader will describe capital letters by using 

words. Using words is a method all synthesisers support. However, it is 

also possible with some synthesisers to use a sound to indicate capitals. 

To do this: 
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1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + S. This will open the "Speech" menu. 

3. DOWN ARROW to "General Announcements" and press ENTER. This 

will open the "General Announcements" dialog box. 

4. TAB to the Use Beeps for Capital Announcement" check box and press 

SPACEBAR to select this item. Note that this item will not be available if 

your current synthesiser does not support this option. 

5. TAB to the "Use sound" list and use the Arrow Keys to select the sound 

you want to use to indicate capitals. 

6. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 

The following table describes how Dolphin ScreenReader indicates capitals 

when you are using words and when you are using sounds. 

Capital Announcements 

Description Words Sounds 

Reading a single capital 

letter 

Caps + letter 1x beep 

Reading a word with an 

initial capital 

Capital + word 1x beep 

Reading a word written 

using capital letters 

All Caps + 

word 

2x beep 

Reading a word written with 

a mixture of lower case and 

upper case letters 

Mix caps + 

word 

2x beep 
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5.14.4  Using a pitch change to indicate capitals when spelling 
characters 

You can indicate a capital letter by raising the pitch of your synthesiser's 

voice. This option is available when spelling characters. 

Examples when you are spelling characters: 

 You have Character Echo set to echo each character you type. 

 You move across a line of text a character at a time. 

 You delete a character. 

To indicate capitals with a change in pitch: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + S. This will open the "Speech" menu. 

3. DOWN ARROW to "Voice Preferences" and press ENTER. This will 

open the "Voice Preferences" dialog box. 

4. TAB to the "Increase voice pitch for spelt capitals" check box and press 

SPACEBAR to select this item. Note that this item will not be available if 

your current synthesiser does not support this option. 

5. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 
  

5.15  Speak the keys you press 

You can add key announcements to your key presses. This can provide 

reassurance when using your keyboard. 

To use Key Echo: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 
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2. Press ALT + S. This will open the "Speech" menu. 

3. DOWN ARROW to "Keyboard Announcements" and press ENTER. 

This will open the "Keyboard Announcements" dialog box. 

4. Press SPACEBAR to deselect the "Automatic key echo" check box. 

5. TAB to the "Selected key echo" group and select the key groupings you 

want spoken when pressed. 

6. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 
  

5.16  Change what Dolphin ScreenReader tells you about each 
type of control 

 

You can control what Dolphin ScreenReader automatically tells you about a 

button, a check box, a menu item or any other type of control by changing 

your Verbosity Level. The lower the Verbosity Level, the less information 

Dolphin ScreenReader automatically announces about the control. 

To change Verbosity Level: 

1. Press LEFT CONTROL + SPACEBAR. 

The Dolphin ScreenReader control panel opens. 

2. Press ALT + S. 

The "Speech" menu opens. 

3. DOWN ARROW to "Verbosity Level" and RIGHT ARROW. 

A sub-menu opens. 

4. Use the Arrow Keys to select a menu item and press ENTER. 

The Verbosity Level changes and the menu closes. 
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You can also change Verbosity Level using a Dolphin ScreenReader hot 

key. 

Speech Hot Key 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Verbosity Scheme cycle  CAPS LOCK + 

EQUALS 

CAPS LOCK + 

V 

 
  

5.17  Change how repeated characters are read 

You can change the way Dolphin ScreenReader reads repeated characters 

that may appear on a line. You can have characters like dashes or plus 

signs individually spoken, read as a numeric value or indicated with a 

sound. 

To do this: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + S. This will open the "Speech" menu. 

3. DOWN ARROW to "General Announcements" and press ENTER. This 

will open the "General Announcements" dialog box. 

4. TAB to the "Repeats" button and press SPACEBAR. This will open the 

"Repeats" dialog box. 

5. Choose how Dolphin ScreenReader should read repeated characters 

by selecting from the options available. 

6. TAB to the "Close" button and press SPACEBAR. This will confirm your 

changes and closes the dialog box. 
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To have Dolphin ScreenReader use your settings requires you to have 

"Repeats" check box selected in the "Text Style Announcements" dialog 

box. 

To do this: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + S. This will open the "Speech" menu. 

3. DOWN ARROW to "Text Style Announcements" and press ENTER. 

This will open the "Text Style Announcements" dialog box. 

4. For each area you want your repeat settings used, TAB to the 

"Repeats" check box and press SPACEBAR to select this item. 

5. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 

 





 

 49 

 

C H A P T E R  6  

Braille settings 

6.1  Turn Braille output off or on 

 

You can turn off or on Braille output using the "Braille" options in the 

Dolphin ScreenReader control panel or by using hot keys. 

To turn Braille output off or on: 

Press LEFT CONTROL + LEFT SHIFT + 0. 
  

6.2  Show capital letters 

Some versions of Literary Braille denote capital letters by prefixing the 

letter or contraction with a special sign called a Capital Sign. Other versions 

of Literary Braille permit the omission of any such notation, thus saving 

space. 

To show or hide the displaying of the capital letter sign in Literary Braille: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + B. This will open the Braille menu. 

3. DOWN ARROW to "Characters" and RIGHT ARROW to open its 

sub-menu. 

4. Select "Options" and press ENTER. This will open the "Characters" 

dialog box. 
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5. In the "Literary" group box select "Show Capitals" to display the Capital 

Sign. Unselect this option to hide the Capital Sign. 

6. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 

In addition to the selection of the "Show Capitals" check box and 

irrespective of Computer Braille and Literary Braille is the option to 

"Tremble capitals". This check box is also in the "Characters" dialog box. 

Choosing this check box will mean any capital letters will blink. You can 

control the rate of blinking by the "Blink rate" setting in the "Cursor" dialog 

box. Blinking capitals in 6-dot Braille is especially useful because Computer 

Braille often uses dots 7 or 8 to denote capital letters. 
  

6.3  Show cursor position 

You can indicate the cursor position on your Braille display. This can be 

useful in edit areas. 

To show the cursor position on the Braille display: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "Cursor" and RIGHT ARROW to open its sub-menu. 

4. Select "Visible" and press ENTER to select this item. 

To turn off showing the cursor position, simply repeat the steps above and 

deselect the "Visible" menu item. 

You can also show or hide the cursor position by using a Braille button 

command. Please refer to your Braille display commands for further details. 
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6.4  Show enhanced characters (bold, italic, etc.) 

You can indicate any enhanced characters on your Braille display by 

adding dot 8 to the cell. An enhanced character is any character other than 

normal, like a bold character, an underlined character or a character in a 

different size font or different colour font. 

One example where this can be useful is to find out the shortcut key for 

menu items and controls in dialog boxes. The underlined letter has dot 8 

added to it. 

To turn Enhanced Display Mode on: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "Characters" and RIGHT ARROW to open its 

sub-menu. 

4. Select "Enhanced" and press ENTER to select this item. 

To turn off showing enhanced characters, simply repeat the steps above 

and deselect the "Enhanced" menu item. 

You can also show or hide Enhanced Characters by using a Braille button 

command. Please refer to your Braille display commands for further details. 

You set what is an enhanced character in the "Characters" dialog box. You 

open the "Characters" dialog box by selecting the "Options" item in the 

"Characters" sub-menu. This dialog box contains an "Enhanced 

Characters" group. 
  

6.5  Turn off focus tracking 

In normal operation, Braille output shows the focus. Dolphin ScreenReader 

calls this "tracking the focus". 
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You can turn tracking the focus off. This has the effect of leaving the Braille 

display "locked" on a particular area of the screen. For example, you could 

turn Tracking off and monitor the progress of an Internet download. 

To turn off Tracking: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "Layout" and RIGHT ARROW to open its sub-menu. 

4. Select "Tracking" and press ENTER to deselect this item. 

To turn on Tracking, simply repeat the steps above and select the 

"Tracking" menu item. 

You can also turn off or on Tracking by using a Braille button command. 

Please refer to your Braille display commands for further details. 

Notes: 

 Turning Tracking off switches you into Braille Physical Mode. You 

return to your previous Braille mode when you turn Tracking on again. 

 You can continue to move around with Tracking turned off. 
  

6.6  Show the physical make up of the screen 

There are two ways of positioning information on your Braille display. 

 Logical Mode.  

This is the default mode used by Dolphin ScreenReader. In this mode 

the Braille display will show the logical association of any incidental 

text with the focus. This is similar to the speech output. The nature of 

Logical Mode means that the Braille display will not show the position 

of items on the screen. 
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 Physical Mode. 

This mode provides the opportunity to determine the physical layout of 

objects on the screen. In Physical mode, you can either show the 

characters on the line and the gaps between them (useful for general 

layout), or show a more precise layout of the position of the 

characters on the line (useful for precise document formatting).  

To turn on Physical Mode: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "Layout" and RIGHT ARROW to open its sub-menu. 

4. Select "Physical Mode" and press ENTER to select this item. 

To turn on Logical Mode, simply repeat the steps above and deselect the 

"Physical Mode" item. 

You can also switch modes by using a Braille button command. Please 

refer to your Braille display commands for further details. 

You set how Physical Mode shows the make up of the screen in the 

"Layout" dialog box. You open the "Layout" dialog box by selecting the 

"Options" item in the "Layout" sub-menu. 
  

6.7  Choose Computer Braille or Literary Braille 

Dolphin ScreenReader supports two forms of Braille output: 

 Computer Braille. 

Computer Braille strictly uses one Braille cell per character, whatever 

that character is. It is of most use in applications where every 

character is of importance, you need to distinguish each possible 

character and space is not at a premium. 

 Literary Braille. 

Literary Braille takes advantage of letter combinations in a language 
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and forms them into contractions, thus saving space. The term 

Literary Braille covers both grade 1 and grade 2 Braille tables. Literary 

Braille is of most benefit reading ordinary text. 

To change to Literary Braille: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "Characters" and RIGHT ARROW to open its 

sub-menu. 

4. Select "Literary" and press ENTER to select Literary Braille output. 

To change to Computer Braille, simply repeat the steps above and deselect 

the "Literary" menu item. 

You can also switch between Literary Braille and Computer Braille by using 

a Braille button command. Please refer to your Braille display commands 

for further details. 

To select which Braille output tables are used, for example, which Braille 

language, use the options in the "Braille General Preferences" dialog box. 
  

6.8  Input using your Braille display 

 

Some Braille displays have a group of six or eight buttons arranged like a 

Braille writer. You can use these to simulate typing on your computer 

keyboard. 

To turn Braille Input on or off: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 
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2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "Input" and RIGHT ARROW to open its sub-menu. 

4. Select "Braille Keys" and press ENTER. Braille input is on when the 

menu item is checked. Deselect this menu item to turn off Braille input. 

You can input using either Computer Braille or Literary Braille. To use 

Literary Braille input you must also ensure the "Literary Input" item is 

selected in the same sub-menu. Computer Braille input is used when 

"Literary Input" is unselected.  

When you use Computer Braille input, you use 8 dots and each Braille 

character you type will type one character in your document. 

When you use Literary Braille input, you use 6 dots and use uncontracted 

or contracted Braille (depending on the chosen input language).  Please 

note that the Braille characters you type will only appear in your document 

when you press the Braille Space key, or another key which is not a 

combination of Braille dots. 

To select which Braille input tables are used, for example, which language, 

use the options in the "Braille General Preferences" dialog box. 
  

6.9  Change Braille table 

Dolphin ScreenReader supports two forms of Braille output: Computer 

Braille and Literary Braille. The term Literary Braille covers both grade 1 

and grade 2 Braille tables. 

To select which Braille tables are used, for example, which language, use 

the options in the "Braille General Preferences" dialog box. Here you can 

set a language for the "Unicode to Braille Conversion" (Computer Braille) 

table and a language for the "Unicode to Literary Braille Conversion" table. 

Tip: The "Literary" item in the Braille, "Characters" sub-menu 

switches you between Computer Braille and Literary Braille output. 

Deselect this menu item to choose Computer Braille output. For 
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more information go to the "Choose Computer Braille or Literary 

Braille" topic. 

  

6.10  Change Braille display 

Dolphin ScreenReader works with many different Braille displays. To see 

what Braille displays are supported please visit the Dolphin web site or 

contact your local Dolphin Dealer. 

To change to another Braille display: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "General Preferences" and press ENTER. This will 

open the "General Preferences" dialog box. 

4. CONTROL + TAB to the "Braille Configuration" tab. 

5. TAB to the "Select Braille Display" button and press ENTER. This will 

open a dialog box that lists all Braille displays currently detected by 

Dolphin ScreenReader. 

6. Use the Arrow Keys to select an alternative Braille display. 

7. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. You return to the "General 

Preferences" dialog box. 

Your new Braille display should now be in operation. 

If your new Braille display is not listed by Dolphin ScreenReader: 

 Check you have successfully connected your Braille display to your 

computer. 

 Check you have successfully followed any Braille display install and 

setup procedures recommended by the display manufacturer. 
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 Check Dolphin SAM detects the device. To check that Dolphin SAM is 

configured correctly go to the "General" menu in the Dolphin 

ScreenReader control panel and select the "Advanced Options" menu 

item. In the "General Advanced Options" dialog box open the "System 

Configuration" property sheet and then select the "SAM Setup" button. 

If problems persist please contact your Braille display supplier for 

assistance. 
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C H A P T E R  7  

Braille reading 

7.1  Learn what your Braille buttons do 

You can use the Dolphin ScreenReader Key Describer to help you get 

familiar with your Braille display. An application will not see or act on any 

keys pressed when you use Key Describer. 

To turn on or off "Key Describer": 

Press CAPS LOCK + SLASH. 
  

To view or download a copy of the latest default Braille display hot keys 

visit www.yourdolphin.com/braillekeys. 

http://www.yourdolphin.com/braillekeys 
  

7.2  Moving around the screen 

As you use your application the Braille output will automatically show the 

control you are currently on. If you are using Logical Mode, the Braille will 

also show any text associated with the control. 

You can use the navigation features to move the Braille display to show 

other information, or to move the Braille along if the contents of the current 

control will not fit. 

The most important keys are the Read Backwards and Read Forwards 

keys. These move the display along the line to show the previous and next 

portions of the text. 

Braille Navigation Hot Keys 
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Function Hot Keys Braille Buttons 

Move forward LEFT 

CONTROL + 

LEFT SHIFT + 

PERIOD 

FORWARD 

command 

Move backwards LEFT 

CONTROL + 

LEFT SHIFT + 

COMMA 

BACK 

command 

The distance the Braille will move is governed by a setting in the Control 

Panel called the Scroll Margin. This value is set in the "General 

Preferences" dialog box. 

Other navigation keys that are available and will typically have Braille 

Button assignments are: 

 Line Start 

This will move the Braille display to show the content at the beginning 

of the line. This will also move the display to the beginning of any 

incidental text when in Logical Mode. 

 Line End 

This will move the Braille display to show the content at the end of the 

line. This will also move the display to the end of any incidental text 

when in Logical Mode. 

  Width Left 

This will move the Braille display to show the content one full display 

width to the left. 

 Width Right 

This will move the Braille display to show the content one full display 

width to the right. 

 Half Width Left 
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This will move the Braille display to show the content half width to the 

left. 

 Half Width Right 

This will move the Braille display to show the content half width to the 

right. 

 Cell Left 

This will move the display to show the content one Braille cell to the 

left. 

 Cell Right 

This will move the display to show the content one Braille cell to the 

right. 

 Line Up 

This will move the display to show the content one line up. 

 Line Down 

This will move the display to show the content one line down. 

 Top 

This will move the Braille display to show the content at the top left of 

the window. 

 Bottom 

This will move the Braille display to show the content at the bottom 

left of the window. 

 Go to Focus 

Move the Braille display back to the position of the focus. 

The Go to Focus key will move the Braille back to the place where you 

started navigation, i.e. to the current control. This can be particularly useful 

when you are editing a document and wish to move straight back to the 
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cursor. Of course, if you type anything, the Braille will jump back 

automatically, but this key allows you to return to the focus without affecting 

your application. 

Notes: 

 If you move up or down, you will temporarily switch into Physical 

Mode. Logical Mode is restored when you press Go to Focus. 

 Any navigation from the Braille display is independent from the 

Speech and Dolphin Cursor. 
  

7.3  Change what Dolphin ScreenReader tells you about each 
type of control 

 

You can control what Dolphin ScreenReader automatically tells you about a 

button, a check box, a menu item or any other type of control by changing 

your Verbosity Level. The lower the Verbosity Level, the less information 

Dolphin ScreenReader automatically announces about the control. 

To change Verbosity Level: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "Verbosity Level" and RIGHT ARROW to open the 

sub-menu. 

4. Select a Verbosity Level and press ENTER to confirm your change and 

close the menu. 

You can also change Verbosity Level using a Dolphin ScreenReader hot 

key. 
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To change Verbosity Level: 

Press LEFT SHIFT + CAPS LOCK + EQUALS. 
  

7.4  Move the cursor using the Cursor Routing buttons 

Many Braille displays have buttons located above each cell, called Cursor 

Routing Buttons. If you press one of these buttons then Dolphin 

ScreenReader will generate a single mouse click at that corresponding 

position. 

Examples: 

 Pressing the Routing Button In an edit area has the effect of instantly 

moving the cursor to that point. 

 Pressing a routing button above a push button will activate the button. 

 Pressing a routing button above a check box will toggle the state of 

the check box. 

Some Braille displays have a second row of Routing Buttons. This second 

row can be used to describe the character at the corresponding position. 
  

7.4.1  Change what the Cursor Routing buttons do 

You can change what the Cursor Routing buttons do by changing settings 

in the Dolphin ScreenReader control panel. 

To do this: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "Input" and RIGHT ARROW to open its sub-menu. 
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4. Select "Routing Buttons" and press ENTER. This will open the "Routing 

Buttons" dialog box. 

5. Select the action you want the Routing Buttons to perform. 

6. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 
  

7.4.2  Change what the Cursor Routing buttons do while using the 
Dolphin Cursor 

You can change what the Cursor Routing buttons do while you are using 

the Dolphin Cursor by changing settings in the Dolphin ScreenReader 

control panel. 

To do this: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "Input" and RIGHT ARROW to open its sub-menu. 

4. Select "Dolphin Cursor Options" and press ENTER. This will open the 

"Dolphin Cursor Options" dialog box. 

5. Select the action you want the Routing Buttons to perform. 

6. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 
  

7.4.3  Change what the Cursor Routing buttons do above Status Cells 

You can set Routing Buttons above Status Cells to perform Dolphin 

ScreenReader commands.  

This provides a useful function for these buttons which otherwise would 

have no purpose because their position means they cannot be used to 

route the cursor. 
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Use the "Keyboard and Hot Keys" dialog box to add a Routing Button to a 

command. 
  

7.5  Check text attributes 

Every character has a series of properties (attributes) associated with it, 

such as its size, font and colour.  

You can learn a characters attributes by switching to Attribute Mode. 

Two different Attribute Modes are available. 

 Cycle Attributes. 

 Describe Cell. 

 The Cycle Attributes function uses special dot combinations to show the 

attributes of every character on the Braille display at once.  By contrast, 

the Describe Cell function writes a full description of just one character on 

the Braille display. 

Braille Attributes Mode Hot Keys 

Function Hot Keys Braille Buttons 

Cycle the attributes of the 

characters shown on the 

display 

LEFT 

CONTROL + 

LEFT SHIFT + 

6 

CYCLE 

ATTRIBUTES 

command 

Describe the attributes of a 

single character 

LEFT 

CONTROL + 

LEFT SHIFT + 

7 

DESCRIBE 

CHARACTER 

command 
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7.5.1  Cycle attributes 

The Cycle Attributes key will cycle through the various attributes of the 

characters currently shown on the Braille display. Each cell will indicate the 

attribute of the character that was at that position. 

The Cycle Attributes command is a multi action. 

1. Pressing the key the first time will display the size of each character.  

2. Pressing the key again will display the style of each character.  

3. Pressing the key again will display the foreground and background 

colours of the characters. 

4. Pressing the key again will display the foreground colour. 

5. Pressing the key again will display the font of the characters. 

6. A final press of the key will return to normal mode. 

As you cycle through the attributes and you press a key on the computer 

keyboard or the Go to Focus command on the Braille display, then you will 

return to the normal character display mode. 

An explanation on the Braille output for each attribute is described below. 

The precise meaning of the dots shown for some of the attributes displayed 

with Cycle Attributes key may not be immediately obvious.  The function is 

provided so that it is easy to find when an attribute changes.  You may 

also find the Enhanced Characters function helpful. 

Size 

The size of characters is shown as a two digit number representing the 

point size. The upper four dots of the Braille cell are the tens digit and the 

lower four dots are the units. For example, a ten point character is shown 

by dots 1678 (A above J). 
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Style 

The styles of characters are shown as follows: 

 Dot 1: Italic. 

 Dot 4: Underline. 

 Dot 2: Struck out and/or non-normal colour. 

 Dot 5: Bold. 

 Dot 3: Light. 

 Dot 6: Selected. 

 Dot 7: Link. 

 Dot 8: Normal (i.e. not italic and not underlined and not struck out and 

not bold and not light). 

Colour 

The foreground and background are shown with the upper four dots 

representing the foreground and the lower four dots representing the 

background. 

Foreground Colour 

The foreground attribute mode shows just the character’s foreground colour 

using all eight dots of the cell. The colour is represented using the 

red/green/blue (RGB) method: dots 123 show the amount of red, dots 456 

show the amount of green and dots 78 show the amount of blue. White is 

shown as all eight dots and black is shown as an empty cell. 

Font 

Each cell displays a symbol representing the character's font name. As 

only a single character is used for the whole of the name, the symbol may 

not seem related to the name it represents, for example the Arial font is 
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represented by dots 15678.  To find the full name of the font, use the 

Describe Character] function. 
  

7.5.2  Describe character 

The Describe Character key will display a full description of the character at 

the cursor position. This is useful if you want to find out what an unfamiliar 

dot combination represents.  

For example, if you find a symbol you do not understand: 

1. Use the Cursor Route button to move focus to the character. 

2. Press Describe Character to describe the character's attributes. 

3. Use the Navigation keys to move along the description if it does not fit 

on your display. 

The description includes a description of the character itself together with 

all the attribute information available. The information is written out in full. 

You will see a description similar to the following: 

"(Dots 467) POUND, Arial, normal, 14PT, Black, White, 00a3" 

This shows: 

 The character being described. In this example it is dots 467. 

 The description of the character (the Pound sign). 

 The font name of the character. 

 The style. 

 The size ("PT" is an abbreviation for "point"). 

 The foreground colour of the character. 

 The background colour. 
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 The Unicode value of the character. 
  

7.6  Show information on the Braille display Status Cells 

Many Braille displays have a special group of cells to the left of the main 

display area to display status information.  

Dolphin ScreenReader can use these status cells to display extra 

information about the character under the cursor, for example, its size and 

colour. 

You can show any of the following status information: 

 Features on display. 

 Cursor position across the line. 

 Type of the current focus. 

 Any of the attributes of the character under the cursor 

You can select as many options as you want, except that you will be limited 

to the number of status cells you have on your Braille display. 

Each option takes one cell. 

Notes: 

 Although your Braille display may not have dedicated status cells, you 

may be able to simulate status cells using the SAM driver. To check 

this, call up the Driver Configuration dialog box from the SAM Control 

Panel. SAM can be opened from the "General Advanced Options" 

dialog box. 
  



 

70 Braille reading 

 

7.7  Show Braille output on the screen 

You can show what is being output to your Braille display inside a small 

fixed window on the screen. This is the "Show Braille On Screen" item in 

the "Braille" menu. 

To turn the "Show Braille On Screen" option off or on: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + B. This will open the "Braille" menu. 

3. DOWN ARROW to "Show Braille On Screen" and press ENTER. This 

will confirm the change and close the menu. 

You can also show or hide the window with a hot key: 

Press LEFT CONTROL + LEFT SHIFT + 1. 

You can change the position and size of the window through options in the 

"Braille Advanced Options" dialog box. 
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C H A P T E R  8  

Dolphin Cursor 

The Dolphin cursor is a special kind of cursor created by Dolphin 

ScreenReader. The Dolphin Cursor allows you to read the contents of the 

screen line by line, or word by word, or letter by letter using your keyboard. 

You can use the Dolphin cursor to review any part of your computer's 

screen. 
  

8.1  Turn on the Dolphin Cursor 

You can turn on the Dolphin Cursor and position it either at the last place it 

was located or at the current focus position. 

Dolphin Cursor Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Turn on Dolphin Cursor NUMPAD 

MINUS 

CAPS LOCK + 

Z 

Turn on Dolphin Cursor and 

position it at the current 

focus position 

NUMPAD 

ASTERISK 

CAPS LOCK + 

MINUS 

 
  

8.2  Turn off the Dolphin Cursor 

If you have turned on the Dolphin Cursor, then to turn off the Dolphin 

Cursor you must use the following hot key. 

 

Dolphin Cursor Hot Keys 
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Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Turn Dolphin Cursor off NUMPAD 

MINUS 

CAPS LOCK + 

Z 

Turn off the Dolphin Cursor 

and prevent the Dolphin 

Cursor being automatically 

turned on 

CONTROL + 4 No 

Assignment 

The Dolphin Cursor also turns off automatically if something happens on 

the screen, for example, a message window appears. 
  

8.3  Turn off the automatic Dolphin Cursor 

Dolphin ScreenReader will automatically turn on the Dolphin Cursor in 

certain places in certain applications. This default behaviour will occur 

usually when it is not possible to read the text on the screen line by line 

using the keyboard commands available in the application. 

If you want to prevent this behaviour because you do not wish to use the 

Dolphin Cursor then you must deselect the "Use Dolphin Cursor 

automatically" check box.  

To turn off the automatic use of the Dolphin Cursor: 

1. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

2. Press ALT + S. This will open the "Speech" menu. 

3. DOWN ARROW to "Advanced Options" and press ENTER. This will 

open the "Advanced Options" dialog box. 

4. In the "Cursor" properties, press SPACEBAR to deselect the "Use 

Dolphin Cursor automatically" check box. 

5. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 
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6. Press ESCAPE to exit the Dolphin ScreenReader control panel. 

If you want this setting change only to apply to the current application then 

you must first create an Application Settings file. See "Create Application 

Settings" for more information. 
  

8.4  Select text using the Dolphin Cursor 

You can select text from the screen using the Dolphin Cursor. Text includes 

text from dialog boxes and message windows as well as text from web 

pages and documents. 

To select text using the Dolphin Cursor: 

1. Press SHIFT + Arrow Keys to make your selection or press CONTROL 

+ A to select all the text in the current window. 

2. Press CONTROL + C to copy your selection to the Clipboard. 

3. Go to the place you want to insert the selected text. 

4. Press CONTROL + V to paste the content from the Clipboard. 
  

8.5  Search using the Dolphin Cursor Find Command 

You can use the Dolphin Cursor Find Command to perform a basic search 

for text on the screen, in documents and on web pages. You will find more 

advanced Dolphin Cursor Find Commands available with some 

applications. 

To perform a basic search: 

1. Turn on the Dolphin Cursor. 

2. Press F3. This will place you in an invisible edit box. 

3. Enter your search string. The text you enter is case insensitive, you are 

always in Insert Mode and the keyboard layout will match your current 

application. 
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4. Press ENTER to start searching the current window. The Dolphin 

Cursor will move to the first match it finds. 

5. To find the next match, press F4. To find the previous match, press F2. 

Note that Dolphin ScreenReader will remember your last search string until 

you quit Dolphin ScreenReader. This means you can perform the same 

search without entering the search string again. You only need to turn on 

the Dolphin Cursor and press F4 or F2 to search for the next or previous 

match. 
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C H A P T E R  9  

Make the focus easier to see 

 

Dolphin ScreenReader contains options to make viewing the screen more 

comfortable. One of these options is Dolphin ScreenReader Highlighting, 

which makes different types of focus easier to see by attaching a visual 

marker to the focus. 

Types of focus include: 

 Mouse (the pointer controlled by the mouse). 

 Cursor (the beam cursor used in edit areas). 

 Line (the line the beam cursor is positioned). 

 Focus (the focus in dialog boxes and menus). 

You can choose a pre-set Dolphin ScreenReader Highlighting Scheme or 

create your own personal custom scheme. You choose a scheme through 

the "Visual" options in the Dolphin ScreenReader control panel. 

To create a custom scheme you must select "Settings". from the list of 

Highlighting Schemes. When you choose "Settings" Dolphin ScreenReader 

automatically switches to the "Custom" scheme before opening the 

Highlighting Options dialog box. Dolphin ScreenReader also uses the 

previous scheme's values to make the default values for the new custom 

scheme. 

Tip: If you see no visual effect when choosing a scheme then check to 

ensure "Highlighting" is turned on. You can turn Highlighting on by 

selecting the "Highlighting" option in the "Visual" menu or by selecting the 
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"Highlighting" button in the "Visual" tab of the Dolphin ScreenReader 

control panel. 
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C H A P T E R  1 0  

Doc Reader 

 

The Doc Reader lets you create your own reading environment, where the 

text, background and highlight can all be set to a value that makes reading 

comfortable for you. You can display text from documents, web pages or 

any other source showing text on the screen. 
  

10.1  Launch Doc Reader 

You can launch the Doc Reader by clicking the Doc Reader button on the 

"Visual" page of the Dolphin ScreenReader control panel or by pressing a 

Dolphin ScreenReader hot key. 

Doc Reader Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Launch Doc Reader CAPS LOCK + 

NUMPAD 

PLUS 

ALT + SHIFT 

+ D 

Your text will be loaded into the Doc Reader. This may take a few seconds. 

In the Doc Reader, you can use the Arrow Keys to move the highlight 

through the text or press TAB to move through the Doc Reader toolbar 

options. 
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10.2  Control reading 

The items available on the Doc Reader toolbar control the reading 

environment. For advanced controls, including the colour settings, fonts 

and reading speed please go to the "Doc Reader Settings" dialog box. 

After launching the Doc Reader, you can access the toolbar options by 

pressing TAB. Repeated presses of TAB will move you along the toolbar 

options and finally return you to the document window.  You can also use 

SHIFT + TAB to navigate back across the toolbar buttons. 

Doc Reader toolbar. 

 

You press this button to start or stop the reading of the document. You can 

also start or stop the reading of the document by pressing SPACEBAR. 

When reading, the Doc Reader highlights the current word and 

automatically scrolls the document window. 

 

You press this button to increase the size of the text. The change in the text 

size is independent from the custom font options in the Doc Reader 

Settings dialog box. 

 



 

Doc Reader 79 

 

You press this button to shrink the size of the text. The change in the text 

size is independent from the custom font options in the Doc Reader 

Settings dialog box. 

 

You press this button to cycle through the highlighting options, where you 

can cycle between line, sentence and paragraph highlighting.  The item 

selected determines what is highlighted as a "unit" and the size of 

movement as you navigate up and down through your text. 

 

You press this button to cycle through a number of different colour 

schemes. This is helpful if you find viewing the on screen document text 

difficult because of screen colours and contrast. 

 

You press this button to open the "Mode" menu, where you can choose 

between different viewing mode options such as "Word Wrap" and "Single 

Line". 
  

10.3  Exit Doc Reader 

To do this: 

Press ESCAPE. 
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C H A P T E R  1 1  

Media 

You can use Media to search for and download books and magazines from 

online libraries and to browse news feeds, listen to radio stations and play 

popular podcasts. 

IMPORTANT: The options available in Media will differ depending 

on your Dolphin ScreenReader Control Panel language. 

  

11.1  Media Scan and Read 

You can use Media's "Scan and Read" option to convert printed material 

and image-based files into a format you can read on the computer.  

IMPORTANT: For Dolphin ScreenReader to successfully detect and 

work with a scanning device requires the device to be WIA 

compliant. Today, the majority of scanning devices are WIA 

compliant. Please refer to your manufacturer's support 

documentation for assistance. 

  

11.1.1  Scan and read a file 

You can use the Media "Scan and Read" option to convert image-based 

files into a format you can read on the computer. You do not require a 

scanner or digital camera connected to the computer to perform this task. 

To do this from the Dolphin ScreenReader Control Panel: 

1. Open the "Media" option, select "Scan and Read" and choose "From 

file". 
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2. Select the file you want to convert. If you are using a keyboard you can 

do this by pressing SHIFT + TAB to move into the file list, use the Arrow 

Keys to select the file and then press ENTER. If the file is in a different 

folder, use BACKSPACE to go one level up and use ENTER to open 

folders until you select the file and then press ENTER. 

3. Select your conversion settings. Note that you must choose to open the 

document in Microsoft Word if you want to edit the converted document. 

4. Select the "OK" button. A message window opens showing the 

progress of the conversion. When the conversion is complete the book 

opens in Microsoft Word or the Dolphin ScreenReader Reader. 
  

11.1.2  Scan and read printed material 

You can use the Media "Scan and Read" option to convert print material 

into a format you can read on the computer. 

IMPORTANT: For Dolphin ScreenReader to successfully detect and 

work with a scanning device requires the device to be WIA 

compliant. Today, the majority of scanning devices are WIA 

compliant. Please refer to your manufacturer's support 

documentation for assistance. 

To scan and read printed material from the Dolphin ScreenReader Control 

Panel: 

1. Ensure the scanning device is correctly connected to the computer. 

2. Open the "Media" option, select "Scan and Read" and choose "From 

scanner". 

3. Select your conversion settings. Note that you must choose to open the 

document in Microsoft Word if you want to edit the converted document. 

4. Select the "OK" button. A message window opens showing the 

progress of the conversion. When the conversion is complete a second 

message window opens asking if you want to stop or continue scanning 

pages.  



 

Media 83 

 

5. If you want to scan more pages, add the new page to the scanner and 

select the "Add More Pages" button. Repeat this process until all pages 

are scanned and you are ready to read the text. 

6. When done, select the "Stop Loading Pages" button. The book opens in 

Microsoft Word or the Dolphin ScreenReader Reader. 
  

11.1.3  Adjust "Scan and Read" settings 

The "Scan and Read Settings" dialog box gives you options to choose an 

alternative scanning device, scanning language, level of colour recognition, 

paper size and output folder. 

You can go to the "Scan and Read Settings" dialog box in the Dolphin 

ScreenReader Control Panel by opening the "Media" option, selecting 

"Scan and Read" and choosing "Scan and Read Settings". To learn more 

about the available options see the "Scan and Read Settings" dialog box. 
  

11.2  Media Books 

You can use the "Books" option to search for, download and open books 

and magazines from online libraries. You can also use this option to open 

files on the computer. The books and files you select open in the Dolphin 

ScreenReader Reader. 
  

11.2.1  Open a file in the Dolphin ScreenReader Reader: 

You can use Media to open files on the computer. The file formats you can 

open include text files, ePub files, DAISY books, HTML files and PDF files. 

The files will open in the Dolphin ScreenReader Reader. 

To open a file from the Dolphin ScreenReader Control Panel: 

1. Open the "Media" option, select "Books" and choose "Open file in 

Reader". The "Open" dialog box opens. 

2. Select the file you want to open. If you are using the keyboard you can 

SHIFT + TAB into the file list, use the Arrow Keys to select the file and 
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then press ENTER. If the file is in a different folder, use BACKSPACE 

to go one level up and use ENTER to open folders until you select the 

file and then press ENTER. 

3. Select your conversion settings.  

4. When done, select the "OK" button. A message window opens showing 

the progress of the conversion. When the conversion is complete the 

book opens in the Dolphin ScreenReader Reader. 

5. When you have finished reading the text, press ALT + F4 to close the 

window. 
  

11.2.2  Open a book from an online library 

You can use Media to download and open books from online libraries. The 

files will open in the Dolphin ScreenReader Reader. 

To open a book from the Dolphin ScreenReader control panel: 

1. Open the "Media" option, select "Books" and choose "Online books". 

The Bookshelf dialog box opens showing a list of available libraries. 

Note that some libraries may require you to register with them before 

you can download a book. If you want to use the services of these 

libraries then you must first contact the library to register with them and 

obtain user account details. 

2. Select a library. Depending on the library, you will typically find a 

category list opens giving you further options to narrow down the list of 

books to be shown. This can sometimes be followed by a third and 

fourth list of subcategories. 

3. Browse the available categories and books. Alternatively, if you know 

the title of the book you want to read, type in a key word in the search 

box and press ENTER. Dolphin ScreenReader will search the library for 

matches and list the results. 

4. Select the book you want to read and choose the "Download" button. 

5. When the download is complete, do one of the following: 
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If you want to read the book, select the "Read now" button. The book 

opens in the Dolphin ScreenReader Reader. When you have finished 

reading the text, press ALT + F4 to close the window. 

If you want to copy the book to a portable device, ensure you have a 

portable device connected to the computer and select the "Send To" 

button. A dialog box opens listing the drives you can copy the book to. 

Select the drive and press ENTER. A confirmation message will 

appear when the process is complete. 

If you want to remove the book from the computer, select the "Delete" 

button. A message window opens asking you to confirm the action. 

Choose "Yes" to delete the book. 
  

11.2.3  Open the last book you were reading 

You can continue reading the last book you opened by opening the "Media" 

option, selecting "Books" and choosing "Continue reading...". The book 

opens in the Dolphin ScreenReader Reader. You will be positioned at the 

last place you were in the book. 
  

11.2.4  Open, copy or delete an existing book 

You can open, copy and delete books you download from online libraries. 

To do this from the  Dolphin ScreenReader control panel: 

1. Open the "Media" option, select "Books" and choose "My Books.. A list 

opens showing available books. 

2. Select the book you want to open, copy or delete. A dialog box opens. 

3. Do one of the following: 

If you want to read the book, select the "Read now" button. The book 

opens in the Dolphin ScreenReader Reader. When you have finished 

reading the text, press ALT + F4 to close the window. 

If you want to copy the book to a portable device, ensure you have a 

portable device connected to the computer and then select the "Send 

To" button. A dialog box opens listing the drives you can copy the 
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book to. Select the drive and press ENTER. A confirmation message 

will appear when the process is complete. 

If you want to remove the book from the computer, select the "Delete" 

button. A message window opens asking you to confirm the action. 

Choose "Yes" to delete the book. 
  

11.3  Media News, Radio Stations and Podcasts 

You can use Media's "News", "Radio Stations" and "Podcasts" to keep 

up-to-date with the latest news and entertainment available on the Internet. 

IMPORTANT: Some content requires RealPlayer to be installed. If 

you do not have support for this content then Dolphin ScreenReader 

displays a warning message. The message includes links to web 

sites where you can download the necessary files. 

  

11.3.1  Read a news article 

You can open, browse and read popular news articles available on the 

Internet using Media. 

To do this from the  Dolphin ScreenReader control panel: 

1. Open the "Media" option and select "News". A list of popular news 

feeds opens. 

2. Select a feed. If you do not find a feed you are interested in reading, 

select the "Add" button to explore other available feeds, which you can 

add to the Favourites list. 

3. Select a headline. The dialog box closes and the news article opens in 

the default web browser. 
  

11.3.2  Listen to a radio station 

You can listen to popular radio stations available on the Internet using 

Media. 
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To do this from the  Dolphin ScreenReader control panel: 

1. Open the "Media" option and select "Radio". A list of popular radio 

stations opens. 

2. If you do not find a radio station you are interested in listening to, select 

the "Add" button to explore other available radio stations, which you can 

add to the Favourites list. 

3. Select a radio station. The dialog box closes and the radio station 

begins to play in an associated media player, for example, Windows 

Media Player. 
  

11.3.3  Listen to a podcast 

You can listen to popular podcasts available on the Internet using Media. 

To do this from the  Dolphin ScreenReader control panel: 

1. Open the "Media" option and select "Podcasts". A list of popular 

podcasts opens. 

2. If you do not find a podcast you are interested in listening to, select the 

"Add" button to explore other available podcasts, which you can add to 

the Favourites list. 

3. Select a podcast and then choose an episode. The dialog box closes 

and the podcast begins to play in an associated media player, for 

example, Windows Media Player. 
  

11.3.4  Adjust the favourite news, radio station and podcast listings 

You can add, remove and organise the news, radio stations and podcast 

listings in Media. 

To do this from the  Dolphin ScreenReader control panel: 

1. Open the "Media" option and select the web service you want to modify. 

A list opens showing available services. 
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2. Do one of the following: 

To add a service, select the "Add" button. This opens a new dialog 

box containing a list of the services you can add and a list of the 

currently available services. Select a service to add and then choose 

the "Add" button. Repeat the steps for each service you want to add. 

To remove a service, select the service, then choose the "Remove" 

button. Repeat the steps for each service you want to remove. 

To organise the list of services, select a service and then choose the 

"Up" or "Down" button. This will move the item higher or lower down 

the list of services. Continue to press the button until you position the 

item in the list where you want it to be placed. 

3. When done, select the "Close" button. 
  

11.4  Dolphin ScreenReader Reader keyboard commands 

The books you open from the Bookshelf appear as an HTML page in the 

Dolphin ScreenReader Reader. This allows you to read and navigate the 

book in the same way you read web pages. 

In addition, Dolphin ScreenReader includes the following keyboard 

commands: 

Function Hot key 

Move between document 

window and toolbar 

F6 

Move between the buttons on 

the toolbar 

TAB and SHIFT + TAB 

Play / stop (only available if book 

has audio content) 

F5 

Open Content ALT + C 

Open Settings ALT + S 

Zoom In ALT + I 

Zoom Out ALT + O 

Exit ALT + E (or ALT + F4) 
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Profiles 

Dolphin ScreenReader provides a number of ready-made profiles that allow 

you to quickly tailor the amount of speech feedback generated by Dolphin 

ScreenReader without having to make multiple individual setting changes 

in Dolphin ScreenReader’s control panel. 

To select a profile: 

1. Press LEFT CONTROL + SPACEBAR. The Dolphin ScreenReader 

control panel opens. 

2. Press ALT + F. The File menu opens. 

3. DOWN ARROW to "Profile…" and press ENTER. The "Profiles" dialog 

box opens. 

4. In the "Profile" list box select the name of the profile that you wish to 

use. (A description of what the currently selected profile is tailored to do 

is displayed in the "Description" box directly below.) 

5. Once your desired profile has been selected TAB to the "OK" button 

and press SPACEBAR. This will confirm your profile choice and close 

the dialog box. 

The status bar of Dolphin ScreenReader’s control panel will automatically 

update to display the name of your newly selected profile and any Dolphin 

ScreenReader control panel options that have been disabled by your 

currently selected profile will become grayed out. 

You can also RIGHT CLICK on the profile name in the status bar in order to 

quickly change profiles. 

Here is a list of the available profiles: 
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Note: Not all of the profiles listed below are available in every edition 

of Dolphin ScreenReader. 

 

Magnifier 

Magnification only for mouse users wanting the fastest performance. It will 

magnify, follow the mouse pointer and track the cursor as you type. This 

profile disables all speech and Braille. 

 

Magnifier & Speech with mouse 

Magnification with occasional speech, designed for mouse users. This 

profile enables speech on demand: it will speak text under the mouse and 

includes hotkeys to read the current line, sentence or paragraph. This 

profile disables automatic speech, Dolphin Cursor, reading tools and Braille 

output from a Braille display. 

 

Magnifier & Speech with keyboard 

Magnification with some automatic speech for mouse and keyboard users. 

This profile will speak as you type and read the item in focus, such as 

menus, list items etc. It switches on the Dolphin Cursor so you can read a 

web-page from the keyboard. Read From Here and Doc Reader are also 

included for hands-free reading with speech. This profile disables screen 

reading descriptions and Braille output from a Braille display. 

 

Magnifier & Screen Reader 
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This profile supports both mouse and keyboard users, offering 

magnification with full screen reading in speech and/or Braille via a Braille 

display. This profile is fully-featured and offers the greatest flexibility. 

 

Screen Reader 

Full speech and/or Braille screen reading designed for keyboard users with 

no useful sight. This profile disables all magnification and visual effects and 

enables Braille output via a Braille display. 

 

Screen Reader with visual effects 

Full speech and/or Braille screen reading for keyboard users. This profile 

disables magnification but enables visual effects including visual 

highlighting of the focus. This profile is recommended for those with a 

limited field of vision, or when sharing your screen with a sighted colleague 

or trainer. 
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Guest Mode and Emergency Mode 

The USB edition of Dolphin ScreenReader contains a special feature called 

Guest Mode. Guest Mode allows your USB edition to operate in 

environments where you don't have Administrator access on the computer, 

such as public libraries and hotel business centres. 

 

Startup 

To start your USB edition of Dolphin ScreenReader run the program 

Go.exe (located in the root folder of your USB drive). 

If you've previously installed the additional Dolphin ScreenReader USB 

components onto the computer then your USB edition is likely to auto-start 

when you insert it. 

If you insert your USB edition on a computer that has an existing copy of 

Dolphin ScreenReader already installed that's the same version (or higher) 

as your USB edition, or a computer that you have previously installed the 

additional USB components onto, then you will not have the Guest Mode 

option. Instead your USB edition will run in Normal Mode. 

When you start your USB edition of Dolphin ScreenReader on a new 

computer, or a computer without any additional components installed, you'll 

receive a dialog box with two options: 

 Continue in Guest Mode 

or 

 Install components and restart 
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If you choose the install components option a Windows' User Account 

Control dialog will appear requesting Administrator permissions. If you 

select "Yes" then the additional components will be installed. For Windows 

7 the computer will then be restarted. For Windows 8 and Windows 10 only 

Dolphin ScreenReader will restart and it should then run in Normal Mode. 

 

14.1  Limitations of Guest Mode 

 Magnification will not pan around quite as smoothly as in Normal 

Mode. The computer's CPU and GPU usage may also be a little 

higher than in Normal Mode even when doing nothing. Magnification 

may also be not as smooth if you have more than one monitor in use. 

 The Connect and View video stream is unlikely to update faster than 

30 frames per second. 

 Custom mouse pointers won't work. You can try to use the Windows 

control panel to set a custom mouse pointer, but this may also not 

work if you choose one of Dolphin ScreenReader’s custom mouse 

pointers (due to a bug in Windows). 

 There's no speech and magnification support at the Windows logon 

screen. (You can use Windows Narrator and/or Windows Magnifier 

here instead). 

 Windows' User Account Control dialog boxes will not magnify or 

speak. 

 Any application that runs as Administrator may not be accessible and 

may cause other problems, notably no Dolphin ScreenReader hot 

keys will work and you'll receive limited or no speech and braille 

output. This could also prevent the user interface in Connect and View 

and Line View Mode from working. If you get stuck in this scenario 

press ALT+TAB to switch away from the application. 

 The Internet Updater will continue to work for maps and scripts, but 

will not download product updates. 
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 Modern Windows 8/10 apps should speak and braille just as well as in 

Normal Mode. However, the image smoothing of magnified text may 

not work. 

 Pressing PRINT SCREEN or ALT+PRINT SCREEN will capture the 

magnified screen or the area of the magnified screen where the 

window would be if it wasn't magnified (respectively). To capture 

unmagnified screens toggle magnification off before pressing PRINT 

SCREEN.. 

 TeamViewer remote control sessions will capture the magnified 

screen not the unmagnified screen. 

 Dolphin ScreenReader's touch screen gestures will not work. 

 Dolphin ScreenReader's OCR features may not work. 

Please refer to the Dolphin web site for any other caveats. 

 

Emergency Mode 

If you run a copy of Dolphin ScreenReader that was installed on the 

computer's local hard disk, but some components are missing, then 

Dolphin ScreenReader will start up in Emergency Mode and you'll receive a 

dialog box with two options: 

 Continue in Emergency Mode 

or 

 Install components and reboot 

If you choose the install components and reboot option a Windows' User 

Account Control dialog will appear requesting Administrator permissions. If 

you select "Yes" then the additional components will be installed and the 

computer will be rebooted. 
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Emergency Mode is functionally equivalent to Guest Mode. Please see the 

limitations listed above for further details. 

 

Note: Currently Guest Mode and Emergency Mode are only 

available on Windows version 10 (and below). 
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Settings Files 

15.1  Types of Settings 

Settings can be grouped into the following broad categories: 

 Input Settings control what Dolphin ScreenReader understands about 

the environment it is currently in. Map files and Script files hold this 

data. 

 Output settings are the settings you can configure in Dolphin 

ScreenReader for an application. Application Settings files and 

Situation Settings hold this data. 

 Global Settings are settings you cannot configure on a per application 

basis. This includes hot keys, control panel settings, Update Settings 

and Window Settings. 

You can create, edit, import and export both the input and output settings. 

You do this by choosing items from the "File" menu in the Dolphin 

ScreenReader control panel. 
  

15.2  Create Application Settings 

If you find you regularly adjust Dolphin ScreenReader output settings when 

working in different programs, then using Application Settings can provide 

an automated solution. 

To create an Application Settings file: 

1. Run the application you want to create an Application settings file for. 

2. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 
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3. Press ALT + F. This will open the "File" menu with "New" selected. 

4. RIGHT ARROW into the "New" sub-menu. 

5. Select "Application settings" and press ENTER. This will open the 

"Select Settings file" dialog box. 

6. Select "Create a new settings file". 

7. TAB to the "OK" button and press SPACEBAR. This will open the 

"Create new Settings File" dialog box. 

8. Give the new Application Settings file a name, choose whether to create 

an empty settings file or copy an existing settings file and then TAB to 

the "OK" button and press SPACEBAR. This will close the dialog box 

and return you to the Dolphin ScreenReader control panel. 

Your Application Settings file will now be in use. You can check the 

Application Settings file currently in use by reading the Status Bar in the 

Dolphin ScreenReader control panel. 
  

15.3  Create Situation Settings 

If you find you regularly adjust Dolphin ScreenReader output settings when 

certain dialog boxes appear in an application then using Situation Settings 

can provide an automated solution. Situation Settings are a subset of 

Application Settings and are stored within the same file. 

To create a Situation Setting: 

1. Run the application and get into the situation you want to create a 

Situation Setting for. 

2. Press LEFT CONTROL + SPACEBAR. This will open the Dolphin 

ScreenReader control panel. 

3. Press ALT + F. This will open the "File" menu with "New" selected. 

4. RIGHT ARROW into the "New" sub-menu. 
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5. Select "Situation settings" and press ENTER. This will open the "New 

Situation Settings" dialog box. 

6. Select "Create new Situation". 

7. TAB to the "OK" button and press SPACEBAR. This will open the 

"Enter a name for the new Situation" dialog box. 

8. Give the new Situation Setting a name and then TAB to the "OK" button 

and press SPACEBAR. This will open the "Windows Name" dialog box. 

9. If required, adjust the Window Name and then TAB to the "OK" button 

and press SPACEBAR. This will close the dialog box and return you t 

the Dolphin ScreenReader control panel. 

Your Situation Setting will now be in use. You can check the Situation 

Setting currently in use by reading the Status Bar in the Dolphin 

ScreenReader control panel. 
  

15.4  Save setting changes 

Dolphin ScreenReader automatically saves the changes you make to 

Dolphin ScreenReader settings.  

To stop this behaviour, deselect the "Always save user settings" check box. 

You can find the "Always save user settings" check box in the "Startup 

Preferences" dialog box, which you open through the "General" menu of 

the Dolphin ScreenReader control panel. 

After deselecting the "Always save user settings" check box, an additional 

"Ask user" check box becomes available. If you select this check box then 

you will receive a message window during the quitting of Dolphin 

ScreenReader that asks if you want to proceed without saving the changes 

you have made. 

You can also manually save settings at any time by choosing the "Save 

Settings" menu item. You can find this item in the "File" menu in the 

Dolphin ScreenReader control panel. 
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15.5  Change Map file 

If you are using an application that does not have a specific Map file then 

Dolphin ScreenReader will use the "Default Application" Map file. 

If you find Dolphin ScreenReader does not work well with your application 

using the "Default Application" Map file then it is worth trying another Map 

file. You can try as many Map files as you like. 

Tips: 

 Try using a Map file for a different version of the same application. 

You may find a Map file for an old version of an application will work 

just as well with a new version of the application. 

 Try using a Map file created for an application from the same 

manufacturer. You may find a Map file for a different application but 

created by the same manufacturer will work well with your application, 

for example, if you are using a Microsoft application try using the 

Microsoft Office Map file. 

 Try using the "MSAA Application" Map file if you know your application 

supports MSAA. 

To choose a different Map file: 

1. Run your application. 

2. Press LEFT CONTROL + SPACEBAR. 

The Dolphin ScreenReader control panel opens. 

3. Press ALT + F. 

The "File" menu opens with the "New" menu item selected. 

4. RIGHT ARROW to open the "New" sub-menu, DOWN ARROW to 

"Map" and press ENTER. 

The "Select Map file" dialog box opens. 
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5. DOWN ARROW to select the "Use an existing Map file" option. 

6. TAB to the Map list and use the Arrow Keys to select a Map file. 

7. TAB to the "OK" button and press SPACEBAR. 

The dialog box closes. 

8. Press ESCAPE. 

The Dolphin ScreenReader control panel closes and you go back 

to the application. 

The new Map file's detection settings will take effect immediately. If you 

continue to have problems accessing your application then please contact 

Dolphin or your local Dolphin Dealer for assistance. 
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Hot key conflicts 

Sometimes you can find Dolphin ScreenReader hot keys conflict with an 

application's hot keys. You can resolve this issue in a number of different 

ways. 
  

16.1  Turn off Dolphin ScreenReader hot keys 

You can resolve a hot key conflict between Dolphin ScreenReader and 

your application by turning off Dolphin ScreenReader's hot keys. This 

disables all hot keys except for the hot key to turn on Dolphin 

ScreenReader's hot keys again. 

Action Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Turn off or on hot keys LEFT 

CONTROL + 8 

SHIFT + 

CAPS LOCK + 

3 

 
  

16.2  Tell Dolphin ScreenReader to ignore the next key press 

You can resolve a hot key conflict between Dolphin ScreenReader and 

your application by telling Dolphin ScreenReader to ignore the next key 

press. Once you have released the keys, Dolphin ScreenReader 

automatically turns on its hot keys again. 

Action Hot Keys 
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Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Pass the next key press 

through to your application 

LEFT 

CONTROL + 7 

CAPS LOCK + 

3 

 
  

16.3  Reassign a Dolphin ScreenReader hot key 

You can add, delete or reassign any Dolphin ScreenReader hot key. You 

can do this to resolve hot key conflicts between Dolphin ScreenReader and 

your application or to change a hot key command to a key combination you 

find easier to use. 

To do this: 

1. Press LEFT CONTROL + SPACEBAR. 

The Dolphin ScreenReader control panel opens. 

2. Press ALT + G. 

The "General" menu opens. 

3. DOWN ARROW to "Keyboard and Hot Keys" and press ENTER. 

A submenu opens. 

4. DOWN ARROW to "Hot Keys" and press ENTER. 

The "Hot Keys" dialog box opens. 

5. TAB through, using the "Hot Key Command Set" list and "Command" 

list to select the assigned hot key you want to change. 

6. Use the "Add key" button, "Replace key" button or "Remove key" button 

to change the hot key. 

7. TAB to the "OK" button and press SPACEBAR. 



 

Hot key conflicts 107 

 

Dolphin ScreenReader confirms the changes and closes the 

dialog box. 

Tip: If you find it difficult to locate your hot key from the categories 

and commands available then use the Dolphin ScreenReader Key 

Describer to help. 
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Hot Keys 

17.1  Actions 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Auto Train Graphic Objects LEFT 

CONTROL + 

RIGHT 

BRACKET 

CONTROL + 

CAPS LOCK + 

G 

Control Panel Pop Up Menu CAPS LOCK + 

SPACEBAR 

CAPS LOCK + 

SPACEBAR 

Doc Reader CAPS LOCK + 

NUMPAD 

PLUS 

SHIFT + ALT + 

D 

Exit Auto Train Graphic 

Objects 

ESCAPE ESCAPE 

Freeze The Screen PAUSE No Assignment 

Dolphin ScreenReader Help CAPS LOCK + 

F1 

or RIGHT 

CONTROL + 

RIGHT SHIFT + 

FORWARD 

SLASH 

CAPS LOCK + 

F1 

Dolphin ScreenReader 

Hotkey Helper 

LEFT SHIFT + 

CAPS LOCK + 

F2 

SHIFT + CAPS 

LOCK + F2 

Hot Keys on / off LEFT 

CONTROL + 8 

SHIFT + CAPS 

LOCK + 3 

Open Control Panel LEFT 

CONTROL + 

SPACEBAR 

LEFT 

CONTROL + 

SPACEBAR 
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Pass next key to application LEFT 

CONTROL + 7 

CAPS LOCK + 

3 

Quit CAPS LOCK + 

F4 

CAPS LOCK + 

F4 

Row / Column Mode Toggle LEFT 

CONTROL + 9 

No Assignment 

Screen Refresh LEFT 

CONTROL + 

SEMI COLON 

CAPS LOCK + 

ESCAPE 

Show TTS Language 

selection dialog 

No Assignment CONTROL + 

CAPS LOCK + 

L 

Show TTS selection dialog No Assignment CONTROL + 

CAPS LOCK + 

S 

OCR from your scanner, 

camera, or open PDF file 

CAPS LOCK + 

O 

CAPS LOCK + 

O 

OCR from the Windows 

clipboard 

LEFT 

CONTROL + 

CAPS LOCK + 

O 

LEFT 

CONTROL + 

CAPS LOCK + 

O 

Copy the image currently in 

the Connect and View Viewer 

window to the Windows 

clipboard 

CAPS LOCK + 

P 

CAPS LOCK + 

P 

Restore default user profile LEFT 

CONTROL + 

CAPS LOCK + 

P 

LEFT 

CONTROL + 

CAPS LOCK + 

P 

Unassigned Commands 

The following is a list of unassigned commands within this category. These 

commands can be manually assigned a key combination. 

 Application Help 

 Screen capture 
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 Show Speech Verbosity dialog 

 Start Script Editor 

 Train windows 

 Train windows with a delay 

 Windows Basics Help 
  

17.2  Speech 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Anti-stutter system on / off LEFT 

CONTROL + 6 

No Assignment 

Capitals on / off CAPS LOCK + 

QUOTE 

No Assignment 

Character Echo Cycle CAPS LOCK + 

SEMI COLON 

CAPS LOCK + 

2 

Key Describe Mode CAPS LOCK + 

FORWARD 

SLASH 

CAPS LOCK + 

1 

Language Down LEFT 

CONTROL + 

FULL STOP 

No Assignment 

Language Up LEFT 

CONTROL + 

COMMA 

No Assignment 

Monitor Markers LEFT 

CONTROL + 5 

No Assignment 

Mute LEFT 

CONTROL 

LEFT 

CONTROL 

Next Synthesiser LEFT 

CONTROL + 

LEFT SHIFT + 

RIGHT 

BRACKET 

No Assignment 
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Previous Synthesiser LEFT 

CONTROL + 

LEFT SHIFT + 

LEFT 

BRACKET 

No Assignment 

Speed decrease LEFT 

CONTROL + 

LEFT SHIFT + 

MINUS 

LEFT 

CONTROL + 

ALT + PAGE 

DOWN 

Speed Increase LEFT 

CONTROL + 

LEFT SHIFT + 

EQUALS 

LEFT 

CONTROL + 

ALT + PAGE 

UP 

Verbosity Scheme Cycle CAPS LOCK + 

EQUALS 

CAPS LOCK + 

V 

Voice on / off LEFT 

CONTROL + 0 

LEFT 

CONTROL + 

ALT + 0 

Volume decrease LEFT 

CONTROL + 

MINUS 

LEFT 

CONTROL + 

ALT + MINUS 

Volume increase LEFT 

CONTROL + 

EQUALS 

LEFT 

CONTROL + 

ALT + EQUALS 

 
  

17.3  Speak Keys 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Additional Focus Information LEFT SHIFT + 

NUMPAD 0 

CONTROL + 

CAPS LOCK + 

UP ARROW 

Character NUMPAD 4 CAPS LOCK + 

LEFT ARROW 

Control NUMPAD 

PERIOD 

No Assignment 
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Describe Focus Position NUMPAD 8 No Assignment 

Describe Shortcut Key LEFT SHIFT + 

NUMPAD 

PERIOD 

CONTROL + 

CAPS LOCK + 

LEFT ARROW 

Focus NUMPAD 0 CAPS LOCK + 

UP ARROW 

From Cursor LEFT SHIFT + 

NUMPAD 2 

CAPS LOCK + 

END 

Headings NUMPAD 3 SHIFT + CAPS 

LOCK + LEFT 

ARROW 

Label Above CAPS LOCK + 

NUMPAD 8 

No Assignment 

Label To Left CAPS LOCK + 

NUMPAD 7 

No Assignment 

Line NUMPAD 6 No Assignment 

Paragraph NUMPAD 5 LEFT 

CONTROL + 

LEFT SHIFT + 

CAPS LOCK + 

P 

Paragraph Move To Next CAPS LOCK + 

RIGHT 

BRACKET 

No Assignment 

Paragraph Move To Previous CAPS LOCK + 

LEFT 

BRACKET 

No Assignment 

Repeat Last Speech CAPS LOCK + 

NUMPAD 9 

CAPS LOCK + 

BACK SLASH 

Selection NUMPAD 1 SHIFT + CAPS 

LOCK + DOWN 

ARROW 

Sentence CAPS LOCK + 

NUMPAD 4 

LEFT 

CONTROL + 

LEFT SHIFT + 

CAPS LOCK + 

S 
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Sentence Move To Next CAPS LOCK + 

FULL STOP 

No Assignment 

Sentence Move to Previous CAPS LOCK + 

COMMA 

No Assignment 

Status NUMPAD 2 CAPS LOCK + 

PAGE DOWN 

Table Column CAPS LOCK + 

NUMPAD 6 

SHIFT + CAPS 

LOCK + RIGHT 

ARROW 

Table Column From Cell CAPS LOCK + 

NUMPAD 

PERIOD 

SHIFT + CAPS 

LOCK + PAGE 

DOWN 

Table Column To Cell CAPS LOCK + 

NUMPAD 3 

SHIFT + CAPS 

LOCK + PAGE 

UP 

Table Row CAPS LOCK + 

NUMPAD 0 

SHIFT + CAPS 

LOCK + UP 

ARROW 

Table Row From Cell CAPS LOCK + 

NUMPAD 2 

SHIFT + CAPS 

LOCK + END 

Table Row To Cell CAPS LOCK + 

NUMPAD 1 

SHIFT + CAPS 

LOCK + HOME 

To Cursor LEFT SHIFT + 

NUMPAD 1 

CAPS LOCK + 

HOME 

Where Am I? NUMPAD 7 CAPS LOCK + 

PAGE UP 

Window NUMPAD 9 CAPS LOCK + 

B 

Word NUMPAD 5 CAPS LOCK + 

RIGHT 

ARROW 

Unassigned Commands 

The following is a list of unassigned commands within this keyboard hot 

key set category. These commands can be manually assigned a key 

combination. 
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 Label Below 

 Label To Right 

 Word Move To Next 

 Word Move To Previous 
  

17.4  Read From Here 

Function 
Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Click and Read From Here MIDDLE 

MOUSE 

BUTTON 

MIDDLE 

MOUSE 

BUTTON 

Read From Here NUMPAD 

PLUS 

CAPS LOCK + 

DOWN 

ARROW 

Stop Reading NUMPAD 

PLUS 

or ESCAPE 

or LEFT 

CONTROL 

or RIGHT 

CONTROL 

CAPS LOCK + 

DOWN 

ARROW 

or ESCAPE 

or LEFT 

CONTROL 

or RIGHT 

CONTROL 

Stop Reading and switch 

focus 

NUMPAD 

MINUS 

or SPACEBAR 

SPACEBAR 

 
  

17.5  Dolphin Cursor (General) 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Activate Down COMMA No Assignment 
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Activate Press SPACEBAR SPACEBAR 

Activate Up FULL STOP No Assignment 

Add Permanent PlaceMarker 

at Dolphin Cursor 

LEFT 

CONTROL + 

CAPS LOCK + 

A 

LEFT 

CONTROL + 

CAPS LOCK + 

A 

Add Temporary PlaceMarker 

at Dolphin Cursor 

LEFT 

CONTROL + 

LEFT SHIFT + 

A 

LEFT 

CONTROL + 

LEFT SHIFT + 

A 

Automatic Dolphin Cursor on 

/ off 

LEFT 

CONTROL + 4 

No Assignment 

Automatic Dolphin Cursor 

Restricted To Area on / off 

LEFT 

CONTROL + 2 

No Assignment 

Find with Dolphin Cursor F3 SHIFT + CAPS 

LOCK + F 

Find Next with Dolphin 

Cursor 

F4 CAPS LOCK + 

F3 

Find Previous with Dolphin 

Cursor 

F2 SHIFT + CAPS 

LOCK + F3 

Forms Mode Toggle CAPS LOCK + 

ENTER 

CAPS LOCK + 

ENTER 

Interact with Control ENTER ENTER 

Mode Lock LEFT 

CONTROL + 1 

No Assignment 

Teach Graphic Object LEFT 

CONTROL + 

LEFT 

BRACKET 

CAPS LOCK + 

G 

Turn dolphin Cursor Off NUMPAD 

MINUS 

CAPS LOCK + 

Z 

Turn dolphin Cursor On NUMPAD 

MINUS 

CAPS LOCK + 

Z 

Window Lock LEFT 

CONTROL + 3 

No Assignment 
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17.6  Dolphin Cursor (Movement) 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Bottom of window / area LEFT 

CONTROL + 

END 

CONTROL + 

END 

Choose Dolphin Cursor 

restricted to area 

NUMPAD 

SLASH 

LEFT 

CONTROL + 

CAPS LOCK + 

Z 

Dolphin Cursor Page Down CAPS LOCK + 

PAGE DOWN 

LEFT 

CONTROL + 

PAGE DOWN 

Dolphin Cursor Page Up CAPS LOCK + 

PAGE UP 

LEFT 

CONTROL + 

PAGE UP 

End of line END END 

Heading Next CAPS LOCK + 

DELETE 

H 

Heading Prev CAPS LOCK + 

INSERT 

SHIFT + H 

Left LEFT 

ARROWT 

LEFT ARROW 

Left Edge LEFT SHIFT + 

CAPS LOCK + 

HOME 

No Assignment 

Left Word LEFT 

CONTROL + 

LEFT ARROW 

LEFT 

CONTROL + 

LEFT ARROW 

Move Dolphin Cursor to first 

toolbar 

LEFT SHIFT + 

NUMPAD 

MINUS 

CAPS LOCK + 

F8 

Move Dolphin Cursor to next 

application 

LEFT 

CONTROL + 

SINGLE OPEN 

QUOTE 

No Assignment 
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Move Dolphin Cursor to next 

window 

LEFT 

CONTROL + 

TAB 

No Assignment 

Move Dolphin Cursor to 

previous application 

LEFT 

CONTROL + 

LEFT SHIFT + 

SINGLE OPEN 

QUOTE 

No Assignment 

Move Dolphin Cursor to 

previous window 

LEFT 

CONTROL + 

LEFT SHIFT + 

TAB 

No Assignment 

Move Dolphin Cursor to 

Quick Launch bar 

LEFT SHIFT + 

NUMPAD 

STAR 

No Assignment 

Move Dolphin Cursor to 

System Tray 

LEFT SHIFT + 

NUMPAD 

SLASH 

No Assignment 

Move Physical Down LEFT SHIFT + 

CAPS LOCK + 

DOWN 

ARROW 

SHIFT + ALT + 

DOWN 

ARROW 

Move Physical Left LEFT SHIFT + 

CAPS LOCK + 

LEFT ARROW 

SIFT + ALT + 

LEFT ARROW 

Move Physical Right LEFT SHIFT + 

CAPS LOCK + 

RIGHT 

ARROW 

SHIFT + ALT + 

RIGHT 

ARROW 

Move Physical Up LEFT SHIFT + 

CAPS LOCK + 

UP ARROW 

SHIFT + ALT + 

UP ARROW 

Move To Application Cursor NUMPAD 

STAR 

CAPS LOCK + 

MINUS 

Next Dialog F7 CONTROL + 

TAB 

Next Large Object PAGE DOWN PAGE DOWN 
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Next Line DOWN 

ARROW 

DOWN 

ARROW 

Next Main Window F8 CONTROL + 

F6 

Next Object TAB TAB 

Physical Bottom LEFT SHIFT + 

CAPS LOCK + 

PAGE DOWN 

No Assignment 

Physical on off LEFT 

CONTROL + 

LEFT SHIFT + 

9 

No Assignment 

Physical Top LEFT SHIFT + 

CAPS LOCK + 

PAGE UP 

No Assignment 

Previous Dialog LEFT SHIFT + 

F7 

CONTROL + 

SHIFT + TAB 

Previous Large Object PAGE UP PAGE UP 

Previous Line UP ARROW UP ARROW 

Previous Main Window LEFT SHIFT + 

F8 

No Assignment 

Previous Object LEFT SHIFT + 

TAB 

SHIFT + TAB 

Restrict Dolphin Cursor to 

selection 

LEFT 

CONTROL + 

LEFT SHIFT + 

NUMPAD 

MINUS 

No Assignment 

Right RIGHT 

ARROW 

RIGHT 

ARROW 

Right Edge LEFT SHIFT + 

CAPS LOCK + 

END 

No Assignment 

Right Word LEFT 

CONTROL + 

RIGHT 

ARROW 

LEFT 

CONTROL + 

RIGHT 

ARROW 
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Route Dolphin Cursor to 

Mouse 

MIDDLE 

MOUSE 

BUTTON 

MIDDLE 

MOUSE 

BUTTON 

Skip Ahead LEFT 

CONTROL + 

DOWN 

ARROW 

LEFT 

CONTROL + 

DOWN 

ARROW 

Skip Back LEFT 

CONTROL + 

UP ARROW 

LEFT 

CONTROL + 

UP ARROW 

Start of line HOME HOME 

Table Down CAPS LOCK + 

DOWN 

ARROW 

LEFT 

CONTROL + 

ALT + DOWN 

ARROW 

Table Left CAPS LOCK + 

LEFT ARROW 

LEFT 

CONTROL + 

ALT + LEFT 

ARROW 

Table Next CAPS LOCK + 

END 

T 

Table Prev CAPS LOCK + 

HOME 

SHIFT + T 

Table Right CAPS LOCK + 

RIGHT 

ARROW 

LEFT 

CONTROL + 

ALT + RIGHT 

ARROW 

Table Up CAPS LOCK + 

UP ARROW 

LEFT 

CONTROL + 

ALT + UP 

ARROW 

Top of Window / Area LEFT 

CONTROL + 

HOME 

CONTROL + 

HOME 
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17.7  Dolphin Cursor (Mouse Control) 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Drag with Left Mouse Button RIGHT 

CONTROL + 

HOME 

CONTROL + 

CAPS LOCK + 

8 

Drag with Right Mouse 

Button 

RIGHT 

CONTROL + 

RIGHT SHIFT + 

HOME 

CONTROL + 

CAPS LOCK + 

9 

Drop RIGHT 

CONTROL + 

END 

LEFT 

CONTROL + 

CAPS LOCK + 

7 

Left Click at Dolphin Cursor INSERT CAPS LOCK + 

8 

Left Click at Dolphin Cursor 

and switch Dolphin Cursor off 

A No Assignment 

Left Double Click at Dolphin 

Cursor 

Q No Assignment 

Middle Click at Dolphin 

Cursor 

S No Assignment 

Mouse Wheel Down at 

Dolphin Cursor 

X No Assignment 

Mouse Wheel Up at Dolphin 

Cursor 

W No Assignment 

Move Mouse to Focus RIGHT 

CONTROL + 

DELETE 

CAPS LOCK + 

EQUALS 

Right Click at Dolphin Cursor DELETE CAPS LOCK + 

9 

Right Click at Dolphin Cursor 

and switch Dolphin Cursor off 

D No Assignment 

Right Double Click at Dolphin 

Cursor 

E No Assignment 
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Note: In some applications, for example, Internet Explorer and 

Adobe Reader, the above stated hot keys may conflict with a 

Dolphin ScreenReader Quick Navigation Key. Where a conflict 

exists the Quick Navigation key has priority. To use the above stated 

commands in an application with a conflicting Quick Navigation Key 

requires you to re-assign the associated Dolphin Cursor (Mouse 

Control) hot key. 

  

17.8  Dolphin Cursor Selection 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Bottom of window / area LEFT 

CONTROL + 

LEFT SHIFT + 

END 

LEFT 

CONTROL + 

LEFT SHIFT + 

END 

Copy CONTROL + C CONTROL + C 

End of line SHIFT + END SHIFT + END 

Left SHIFT + LEFT 

ARROW 

SHIFT + LEFT 

ARROW 

Left word CONTROL + 

SHIFT + LEFT 

ARROW 

CONTROL + 

SHIFT + LEFT 

ARROW 

Next large object SHIFT + PAGE 

DOWN 

SHIFT + PAGE 

DOWN 

Next line SHIFT + 

DOWN 

ARROW 

SHIFT + 

DOWN 

ARROW 

Previous large object SHIFT + PAGE 

UP 

SHIFT + PAGE 

UP 

Previous line SHIFT + UP 

ARROW 

SHIFT + UP 

ARROW 
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Right SHIFT + RIGHT 

ARROW 

SHIFT + RIGHT 

ARROW 

Right word CONTROL + 

SHIFT + RIGHT 

ARROW 

CONTROL + 

SHIFT + RIGHT 

ARROW 

Select all CONTROL + A CONTROL + A 

Skip ahead LEFT 

CONTROL + 

LEFT SHIFT + 

DOWN 

ARROW 

LEFT 

CONTROL + 

LEFT SHIFT + 

DOWN 

ARROW 

Skip back LEFT 

CONTROL + 

LEFT SHIFT + 

UP ARROW 

LEFT 

CONTROL + 

LEFT SHIFT + 

UP ARROW 

Start of line SHIFT + HOME SHIFT + HOME 

Top of window / area LEFT 

CONTROL + 

LEFT SHIFT + 

HOME 

LEFT 

CONTROL + 

LEFT SHIFT + 

HOME 

 
  

17.9  Item Finder 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Item Finder (multi tab dialog 

box) 

CAPS LOCK + 

TAB 

CAPS LOCK + 

TAB 

Links CAPS LOCK + 

1 

CAPS LOCK + 

F7 

Headings CAPS LOCK + 

2 

CAPS LOCK + 

F6 

Frames or Objects CAPS LOCK + 

3 

CAPS LOCK + 

F9 

Tables CAPS LOCK + 

5 

No Assignment 
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Controls CAPS LOCK + 

6 

CAPS LOCK + 

F5 

Revisions or Comments CAPS LOCK + 

7 

LEFT SHIFT + 

CAPS LOCK + 

R 

Errors CAPS LOCK + 

8 

No Assignment 

 

 

Global Item Finder 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

System Tray items CAPS LOCK + 

0 

CAPS LOCK + 

F11 

For information on Custom Lists please refer to the Dolphin ScreenReader 

Help for the target application. Help information can be obtained from 

Dolphin ScreenReader by pressING CAPS LOCK + F1. 
  

17.10  Text Input 

This category lists keys that become available in Forms Mode that are 

otherwise assigned when using the Dolphin Cursor. 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Cancel ESCAPE ESCAPE 

Delete previous character BACKSPACE BACKSPACE 

Delete this character DELETE DELETE 

Enter ENTER ENTER 

Left one character LEFT ARROW LEFT ARROW 

Move to end of line END END 

Move to start of line HOME HOME 
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Phonetic character LEFT 

CONTROL + 

LEFT SHIFT + 

NUMPAD 4 

No Assignment 

Phonetic line LEFT 

CONTROL + 

LEFT SHIFT + 

NUMPAD 6 

No Assignment 

Read character NUMPAD 4 CAPS LOCK + 

LEFT ARROW 

Read character attributes (set 

1) 

LEFT SHIFT + 

NUMPAD 4 

No Assignment 

Read character attributes 

(Set 2) 

LEFT 

CONTROL + 

NUMPAD 4 

No Assignment 

Read line NUMPAD 6 CAPS LOCK + 

UP ARROW 

Right one character RIGHT 

ARROW 

RIGHT 

ARROW 

Spell line LEFT SHIFT + 

NUMPAD 6 

No Assignment 

Verbose line LEFT 

CONTROL + 

NUMPAD 6 

No Assignment 

 
  

17.11  Braille 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Back LEFT 

CONTROL + 

LEFT SHIFT + 

COMMA 

No Assignment 
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Cycle Attributes LEFT 

CONTROL + 

LEFT SHIFT + 

6 

No Assignment 

Describe Character on / off LEFT 

CONTROL + 

LEFT SHIFT + 

7 

No Assignment 

Forward LEFT 

CONTROL + 

LEFT SHIFT + 

FULL STOP 

No Assignment 

Go To Focus LEFT 

CONTROL + 

LEFT SHIFT + 

FORWARD 

SLASH 

No Assignment 

Hooks on / off LEFT 

CONTROL + 

LEFT SHIFT + 

2 

No Assignment 

Literary Braille on / off LEFT 

CONTROL + 

LEFT SHIFT + 

8 

No Assignment 

Monitor on / off LEFT 

CONTROL + 

LEFT SHIFT + 

1 

No Assignment 

Braille Output on / off LEFT 

CONTROL + 

LEFT SHIFT + 

0 

LEFT 

CONTROL + 

CAPS LOCK + 

0 

Physical / Logical Mode LEFT 

CONTROL + 

LEFT SHIFT + 

9 

No Assignment 



 

Hot Keys 127 

 

Verbosity Scheme Cycle LEFT SHIFT + 

CAPS LOCK + 

EQUALS 

LEFT 

CONTROL + 

CAPS LOCK + 

V 

Unassigned Commands 

The following is a list of unassigned commands within this category. These 

commands can be manually assigned a key combination or may already 

have an assigned Braille display button combination. Please refer to your 

Braille display hot key list for more information. 

Bottom Half Width Left 

Braille Document Read Back Half Width Right 

Braille Document Read Back 

(Dolphin Cursor) 

Input on / off 

Braille Document Read 

Forward 

Layout on / off 

Braille Document Read 

Forward (Dolphin Cursor) 

Line Down 

Cell Left Line Down (Dolphin Cursor) 

Cell Right Line End 

Cursor on / off Line Start 

Cursor style Line Up 

Display Characters Line Up (Dolphin Cursor) 

Display Font Colours Routing Button Action 
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Display Font Foreground 

Colour 

Routing Button Action in 

Dolphin Cursor 

Display Font Name Second Routing Button Action 

Display Font Size Second Routing Button Action 

in Dolphin Cursor 

Display Font Style Top 

Eight Dot Six Dot Tracking on / off 

Enhance on / off Tremble Capitals on / off 

Expand Gaps on / off Width Left 

Flush Input Width Right 

 
  

17.12  Quick Navigation Keys for web browsers 

Dolphin ScreenReader coding includes the following list of hot keys for web 

page navigating. The keyboard commands are available using the Dolphin 

Cursor in supported web browsers. The keyboard commands cannot be 

removed or reassigned. 
  

17.12.1  Quick Navigation Keys 

To move to the previous element use Shift + Key 

Move to Hot key 

PlaceMarker A 

Button B 

List box C 

Different element D 

Edit area E 
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Form F 

Graphic G 

Heading H 

List item I 

Link K 

List L 

Frame M 

Text block N 

Paragraph P 

Block Quote Q 

Radio R 

Table T 

Unvisited link U 

Visited link V 

Check box X 

Heading level 1 - 6 1 - 6 

Landmark ; (SEMI COLON) 

 
  

17.13  Quick Navigation Keys for Microsoft Word 

Dolphin ScreenReader coding includes the following list of hot keys for 

supported versions of Microsoft Word. You cannot remove or reassign 

these keyboard commands. 
  

17.13.1  Quick Navigation Keys 

To move to the previous element use Shift + Caps Lock + Key 

Move to Hot key 

Bookmark CAPS LOCK + A 

Button CAPS LOCK + B 

Comment CAPS LOCK + C 

Different paragraph style CAPS LOCK + D 

Edit form field CAPS LOCK + E 



 

130 Hot Keys 

 

Footnote or Endnote CAPS LOCK + F 

Graphic CAPS LOCK + G 

Heading style CAPS LOCK + H 

List item CAPS LOCK + I 

Link CAPS LOCK + K 

List CAPS LOCK + L 

Text box CAPS LOCK + Y 

Normal style paragraph CAPS LOCK + N 

Object (including graphics) CAPS LOCK + O 

Paragraph CAPS LOCK + P 

Revision CAPS LOCK + R 

Table CAPS LOCK + T 

Check box CAPS LOCK + X 

Section break CAPS LOCK + Z 

Note that you may find various Quick Navigation Keys failing when working 

in a protected document. 
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C H A P T E R  1 7  

Reference 

18.1  New Situation Settings dialog box 

Menu: File > New > Situation Settings 

You can create or choose an existing Situation by using options in the 

"New Situation Settings" dialog box. 

Options: 

 Create New Situation radio button. 

You can create a new Situation Setting by selecting this radio button 

and then choosing the "OK" button. This will move you to the next 

step in the creation process. To review all steps in this process please 

refer to the "Create Situation Settings" topic. 

 Use an existing Situation radio button. 

You can change to another Situation by selecting this option and then 

selecting from the available list. Note the Situation list will show only 

those Situation Settings available in the current Application Settings 

file. 
  

18.2  New Application Settings dialog box 

Menu: File > New > Application Settings 

You can create or choose an existing Application Settings file by using 

options in the Application Settings dialog box. 

Options: 

 Create a new settings file radio button. 

You can create a new Application Settings file by selecting this option 

and then choosing the "OK" button. After selecting the "OK" button, 
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you will go to the next step in the creation process. To review all steps 

in this process please refer to the "Create Application Settings" topic. 

 Use an existing settings file radio button. 

You can change to a different settings file by selecting this option and 

then by selecting a file from the available list. You confirm your 

selection by choosing the "OK" button. The settings will apply 

immediately unless you select the option "Use Default Settings in the 

control panel". If you do select this option then your new settings will 

apply when you go back to your application. 
  

18.3  New Map dialog box 

Menu: File > New > Map 

You can create or choose an existing Map file by using options in the 

"Select New Map" dialog box. 

Options: 

 Create a new Map file radio button. 

You can create a new Map file by selecting this radio button and then 

choosing the "OK" button. This will move you to the next step in the 

creation process. To review all steps in this process please refer to 

the "Mapping Guide". This is available through the Dolphin 

ScreenReader "Help" menu. 

 Use an existing Map file radio button. 

You can change to an alternative Map file by selecting this option and 

then selecting a file from the available list. To learn more about the 

reasons why you might change a Map file please refer to the "Change 

Map file" topic. 
  

18.4  New Script menu item 

Menu: File > New > Script 

You can create a new Script file for the current application by selecting this 

menu item. The new Script file will open in the Dolphin Script Editor. The 
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Dolphin Script Editor includes a "Help" menu with options linking to the 

Scripting Guide. 

Note: If a Script file exists for the current application then this menu 

item will be disabled. To view and edit an existing Script file, go to 

the "File" menu, "Edit" sub-menu and select "Script". 

  

18.5  Edit Situation Settings dialog box 

Menu: File > Edit > Situation Settings 

You can delete or change the properties of your Situation Settings by using 

options in the "Situation Management" dialog box. Note that you must be 

using the Application Settings file that has the Situation Settings to be able 

to edit the Situations in that file. 

 Situation list. 

You can choose the Situation you want to edit or delete from this list. 

 Edit Rules button. 

You can edit the rules of a Situation by selecting this  button. This will 

open the "Define Situation Rules" dialog box. In this dialog box you 

can change the name of the Situation, change the title and class 

details of the Situation rule and add and remove Situation rules. 

 Delete button. 

You can delete the current Situation from your Application Settings file 

by selecting this button. After selecting the button you will receive a 

warning message asking you to confirm that you want to proceed. To 

proceed select the "Yes" button or to cancel select the "No" button. 
  

18.6  Edit Application Settings dialog box 

Menu: File > Edit > Application Settings 

You can delete or change the properties of your Application Settings file by 

using options in the "Settings File Management" dialog box. 

 Application Settings file list. 

You can choose the Application Settings file you want to edit or delete 
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from this list. Note that you cannot delete the "Default Application" 

settings file because this is a Dolphin ScreenReader system file. 

 Properties button. 

You can edit the properties of an Application Settings file by selecting 

this  button. This will open the "Settings File Properties" dialog box. 

In this dialog box you can change the name and version number of 

the settings file and add and remove any the applications associated 

with the file. 

 Delete this settings file button. 

You can delete the current Application Settings file by selecting this 

button. After selecting the button you will receive a warning message 

asking you to confirm that you want to proceed. To proceed select the 

"Yes" button or to cancel select the "No" button. 
  

18.7  Edit Map dialog box 

Menu: File > Edit > Map 

You can edit the properties and rules of a Map file by selecting this menu 

item. To learn more about Map files please refer to the Mapping Guide 

available from the "Help" menu of the Dolphin ScreenReader control panel. 

This dialog box also contains Script options. You can create, reload, edit 

and delete Script files and Extension Script files. To learn more about 

Script files please refer to the Scripting Guide. You can open the Scripting 

Guide from the Dolphin ScreenReader control panel "Help" menu. 
  

18.8  Edit Script menu item 

Menu: File > Edit > Script 

You can edit the Script file for the current application by selecting this menu 

item. The Script file will open in the Dolphin Script Editor. The Dolphin 

Script Editor includes a "Help" menu with options linking to the Scripting 

Guide. 
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Note: If no Script file exists for the current application then this menu 

item will be disabled. To create a new Script file, go to the "File" 

menu, "New" sub-menu and select "Script". 

  

18.9  Visual Highlighting Options dialog box 

Menu: Visual > Highlighting > Settings 

You can make different types of focus easier to see by adding a highlight 

indicator. You can choose the style, colour and behaviour of the highlight in 

the "Highlighting Options" dialog box. 
  

Mouse tab. 

 Highlight the mouse check box. 

Select this check box to turn on the highlighting of this focus. Deselect 

this check box to turn off the highlighting of this focus. 

 Display group. 

Use the "Shape" settings to change the shape and size of the 

highlighting. 

Use the "Show" list box to control when the highlight is visible. Note 

that selecting "On hot key" means you control the highlight using the 

Foci Highlights hot key and selecting "Dynamic tracking" means the 

mouse highlight stays visible until you press a key on the keyboard. 

 Effects group. 

You can choose from different colour options. Depending on the 

option you choose you can also control the colour(s) and/or the 

transparency. 
  

Cursor tab. 

 Highlight the Cursor check box. 

Select this check box to turn on the highlighting of this focus. Deselect 

this check box to turn off the highlighting of this focus. 

 Display group. 
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Use the "Shape" settings to change the shape and size of the 

highlighting. 

Use the "Show" list box to control when the highlight is visible. Note 

that selecting "On hot key" means you control the highlight using the 

Foci Highlights hot key and selecting "Dynamic tracking" means the 

Cursor highlight stays visible until Dolphin ScreenReader is tracking a 

different type of focus, for example, the mouse. 

 Effects group. 

You can choose from different colour options. Depending on the 

option you choose you can also control the colour(s) and/or the 

transparency. 
  

Line tab. 

 Highlight the Line check box. 

Select this check box to turn on the highlighting of this focus. Deselect 

this check box to turn off the highlighting of this focus. 

 Display group. 

Use the "Shape" settings to change the shape and size of the 

highlighting. 

Use the "Show" list box to control when the highlight is visible. Note 

that selecting "On hot key" means you control the highlight using the 

Foci Highlights hot key and selecting "Dynamic tracking" means the 

Line highlight stays visible until Dolphin ScreenReader is tracking a 

different type of focus, for example, the mouse. 

 Effects group. 

You can choose from different colour options. Depending on the 

option you choose you can also control the colour(s) and/or the 

transparency. 
  

Focus tab. 

The term "Focus" refers to the focus used in dialog boxes and menus. 
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 Highlight the Focus check box. 

Select this check box to turn on the highlighting of this focus. Deselect 

this check box to turn off the highlighting of this focus. 

 Display group. 

Use the "Shape" settings to change the shape and size of the 

highlighting. 

Use the "Show" list box to control when the highlight is visible. Note 

that selecting "On hot key" means you control the highlight using the 

Foci Highlights hot key and selecting "Dynamic tracking" means the 

Focus highlight stays visible until Dolphin ScreenReader is tracking a 

different type of focus, for example, the mouse. 

 Effects group. 

You can choose from different colour options. Depending on the 

option you choose you can also control the colour(s) and/or the 

transparency. 
  

Read From Here tab. 

Read From Here is a Dolphin ScreenReader reading mode. You can 

change highlighting options for the current word and the current line being 

read. 

 Word group. 

You must select "Highlight the spoken word" check box to turn on this 

highlighting option. Use the available settings to set how the spoken 

word is highlighted.  

 Line group. 

You must select "Highlight the line" check box to turn on this 

highlighting option. Use the available settings to set how the current 

line being spoken is highlighted. 
  

Dolphin Cursor tab. 

The Dolphin cursor is a special kind of cursor created by Dolphin 

ScreenReader. The Dolphin Cursor allows you to read the contents of the 

screen line by line, or word by word, or letter by letter using your keyboard. 
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You can use the Dolphin cursor to review any part of your computer's 

screen. 

 Current Character group. 

You must select "Highlight the character" check box to turn on this 

highlighting option. Use the available settings to set how the character 

is highlighted. 

 Current Line/Object group. 

You must select "Highlight the line" check box to turn on this 

highlighting option. Use the available settings to set how the current 

line is highlighted. 
  

18.10  Visual Doc Reader Settings dialog box 

Menu: Visual > Doc Reader Settings 

The options available in the "Doc Reader Settings" dialog box control the 

Doc Reader reading environment. You can open this dialog box by 

selecting the item in the "Visual" menu or by selecting the "Settings" button 

from the Doc Reader toolbar. 

Options: 
  

 Font settings. 

In the Doc Reader you can define the font that is used to display the 

text within the document window.  You can also state the font size to 

use. 

 Colour settings. 

You can define the colours to use in the document window. There are 

three categories to which you can apply a foreground and background 

colour too. 

Document colours sets the background and foreground colours used 

in the document window.  However, if "Use document colours" is 

selected then this setting will not be applied. 

Word highlight colours sets the background and foreground colours 

used by the Doc Reader for the current focus.  This shows the 

currently selected word as the Doc Reader reads through the 
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document.  However, if "Invert word" is selected then this setting will 

not be applied.  Instead the highlight will be inverted based on the 

custom colour settings. 

Unit highlight colours sets the background and foreground colours 

for your specified unit of movement.  This is what is highlighted as 

you cursor down through a document. 

 Fetch whole document check box. 

With the "Fetch whole document" check box selected you will load the 

complete document into the Doc Reader.  Depending on the size of 

the document, this may take a few seconds.  This option is only 

supported in DOM enabled applications such as Microsoft Word, 

Adobe Acrobat Reader, Internet Explorer, NotePad, WordPad, etc. 

It is also possible to specify the number of lines you want to fetch by 

unselecting the "Fetch whole document" check box and then 

specifying the number of lines from the available spin control.  This 

will allow you to load a section of a document faster. 

If you are working in an application that does not include DOM 

support then the Doc Reader will load the content from the current 

screen.   

 Invert word check box. 

With the selection of the "Invert word" check box the focus highlighting 

will be an inverted highlight based on the document colours specified 

or based on the actual document's colours depending on what is 

currently enabled. 
  

 Doc Reader speech check box. 

With this option selected the document will be read using your 

selected "Read From Here voice" stated in the "Voice and language" 

dialog box. You can disable speech output in the document window 

by deselecting this check box. 
  

 Use document colours check box. 

Selecting this check box will mean that the Doc Reader will use the 

colours specified in the document instead of its own custom colours.  

 Use document styles check box. 

Selecting this option will mean styles used in the document will 

appear in the Doc Reader. 
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 Wrap line to. list. 

The "Wrap line to" option can be used to insert a line break on a line if 

it exceeds a particular length. This can be useful if lines are scrolling 

outside the current window. 

To disable this feature set the "Wrap line to" value to 0. 
  

18.11  Visual Advanced Options dialog box 

Menu: Visual > Advanced Options 

You can specify settings for a variety of Dolphin ScreenReader features by 

selecting options in the "Visual Advanced Options" dialog box. 
  

General Preferences tab 

 Highlight Hot Key Action group. 

Visual Highlights can be set to appear in a number of different ways. 

One of these ways is to show the selected Highlights when a hot key 

is pressed. How the hot key behaves when pressed is determined by 

the "Show Highlight" list box. This can be set to "Until Hot Key 

pressed again" or "Until Hot Key released". 
  

18.12  Speech Voice Preferences dialog box 

Menu: Speech > Voice Preferences 

You can change various Voice settings in the "Voice Preferences" dialog 

box. 
  

General tab. 

 Volume spin control. 

Use the "Volume" spin control to change how loud the voice sounds. 

This value is independent to the computer's own volume setting. 

 Speed spin control. 

Use the "Speed" spin control to change how fast the voice reads. 
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 Spelling Speed spin control. 

Use the "Spelling Speed" spin control to select how fast characters 

are spelt. You may wish to set this to a speed lower than your normal 

reading speed to make the spelling of words easier to understand. 

 Increase voice pitch for spelt capitals check box. 

Select this check box to have your reading voice rise in pitch when 

spelling a capital letter. Examples when you are spelling characters 

include when you have Character Echo set to echo each character 

you type, when you move across a line of text a character at a time 

and when you delete a character. Note that this item will not be 

available if your current synthesiser does not support this option. 
  

Synthesiser Configuration tab. 

 Select Synthesiser button. 

Choose this button to open the "Select Synthesiser" dialog box. This 

dialog box lists all synthesisers detected by Dolphin ScreenReader. 

If the only option in the list is 'no Speech Device' then this means 

there are no configured speech synthesisers to choose from. Check 

that your synthesiser is configured correctly and make sure it is 

detected by Dolphin SAM. This is done by choosing "SAM Setup" in 

the "General Advanced Options" dialog box. 

 Configure button. 

The configure button will open the Driver Configuration dialog box for 

the synthesiser currently in use. 

 Language Configuration list box and Set Language for button. 

Not all speech synthesisers are able to return information about which 

language or languages they have available. If Dolphin ScreenReader 

determines that this is the case, you can use the language 

configuration box to set the language. If Dolphin ScreenReader 

detects the language then the options will be disabled. 
  

Voice and Language Configuration tab. 

The "Voice and Language Configuration" property sheet lets you choose 

different voices for different speech contexts. A speech context is a special 
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attribute of the text to be spoken which indicates where it came from or 

what Dolphin ScreenReader feature you are using. 

You may find it useful to have different voices for different contexts. This 

can help remind you what feature you are using or the type of control 

currently being used. 

The set of voices that are chosen here, and which are currently defined are 

saved automatically on a per-synthesiser basis. This means that if you 

change synthesiser you will have a different set of voices, but the voices for 

your first synthesiser are saved and will be used again if you switch back to 

your original synthesiser. 

The options in this property sheet are: 

 Screen Reader group. 

In this group you set the Screen Reader "Language" and "Voice". This 

reflects the language and voice Dolphin ScreenReader will use to 

speak prompts. A prompt is something that is spoken which is not 

taken from the screen. Usually, your screen reader language will 

match your Access System Language. 

 Screen group. 

This group lets you set the synthesiser language and voice that is to 

be used to read text from the screen. 

You can choose which voice is to be used to read the text from the 

screen when you are in an edit area, prompt area (e.g. dialog box), a 

menu, or when reading text under your mouse. 

You can also use a different voice when a Dolphin ScreenReader 

feature is being used. This will override any other voice chosen for 

any other area. 

Each of the individual voice list boxes also contains a "No Voice" 

option if you wish to disable speech output for that particular type of 

area. 

 Automatic language switching group. 

The options in this group lets you control automatic language 

switching. Automatic language switching changes the synthesiser 

language to match particular alphabetic scripts; making screen 

reading a more fluent experience.  
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If you have the appropriate synthesiser language installed, you can 

automatically switch between many languages including Latin, Arabic, 

Chinese (Mandarin), Greek, Hebrew, Hindi (Devanagari) and Russian 

(Cyrillic) scripts. 

Note that not all synthesisers support this feature. To learn more 

about available synthesiser languages please contact Dolphin or your 

local Dolphin dealer. 

 Load All Default Voices button. 

Pressing the "Load all Default Voices" button sets all voices back to 

the synthesiser's default value. 

 Voice Exceptions. 

Voice Exceptions are a pronunciation correction feature that allows 

you to correct the mispronunciation of certain words by a specific 

speech synthesiser voice. Those pronunciation corrections may 

involve technical words or words originating from a different language. 

When you press the "Edit" button the Voice Exceptions dialog box will 

be displayed, listing any existing pronunciation correction rules for the 

currently selected speech synthesiser voice. In the Voice Exceptions 

dialog box you're able to add, edit and remove pronunciation 

correction rules for the selected speech synthesiser voice. Each 

individual pronunciation correction rule consists of a "Source word", 

e.g. "Dr", and a "Replacement word", e.g. "doctor". A pronunciation 

correction rule can be made case-sensitive by enabling the "Case 

sensitive matching" check box. Examples of case-sensitive rules in 

English could be: 

 IT; US; VAT; WHO; Polish 

In the above examples, words with uppercase letters are pronounced 

differently if they were written in lowercase. 

 
  

User defined voices tab. 

This property sheet is used to create and modify the speech synthesiser 

voices. You can define your own voices or edit the existing ones. Each 

voice consists of a name and number of synthesiser parameters. The 

actual number of synthesiser parameters, their meaning and possible 

range of values depend upon your synthesiser. 
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The options in this property sheet are: 

 Language list box. 

Use this list box to state what language the new voice is to be based 

upon or what language the existing voice that you want to modify can 

be found in. 

 Voice list box. 

The Voice pull-down list box displays a list of all the currently available 

speech synthesiser voices. Choose the voice that you wish to edit or 

delete from this list. 

 Add, Delete and Rename buttons. 

These buttons let you either create a new voice, delete the currently 

selected voice or rename the currently selected voice. 

 Parameters group box. 

The options in this group box set the basic speech characteristics of 

the voice. This is the pitch and intonation. 

 Other Speech Parameters group box. 

This group box contains other more synthesiser-dependent settings. 

These parameters are in a pull-down list entitled "Parameter". Each 

parameter has a value that can be adjusted in the "Value" list box. 

 Test text edit area. 

The test text is an edit area which contains some text. This text is 

read out every time you change the value of a voice parameter. You 

can edit this text and put in anything you like. This test text lets you 

change parameters and hear what they sound like without the risk of 

changing the voice to something that you can't understand, which 

could occur if you were editing the same voice you were using. 

 Load Default Voices for Current Language button. 

This button loads the default set of voices from the synthesiser. The 

actual set of voices depends upon your synthesiser. The voice names 

used will depend upon your current access system language. 

The voices defined here are unique to Dolphin ScreenReader. They will not 

appear in any other program that uses the same synthesiser. 
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18.13  Speech Character Echo dialog box 

Menu: Speech > Character Echo 

The "Character Echo" dialog box sets what is to be spoken as you type. 

You can have characters, words, both characters and words or nothing 

spoken. 
  

18.14  Speech Keyboard Announcements dialog box 

Menu: Speech > Keyboard Announcements 

The "Keyboard Announcements" dialog box lets you add key press 

announcements to Dolphin ScreenReader spoken output. 
  

18.15  Speech Text Style Announcements dialog box 

Menu: Speech > Text Style Announcements 

You can specify settings for punctuation announcement, number 

announcement and text attribute announcement by selecting options in the 

"Text Style Announcements" dialog box. This dialog box has multiple tabs, 

dividing settings into different contexts. 

Contexts: 

 Edit Areas tab has settings you can apply to text in any control 

designed for text input; where you can view, enter, or edit text or 

numbers. Examples include the document window in a wordprocessor, 

a text box on a web page or an entry field in an address book. 

 Prompt Areas tab has settings you can apply to all areas with the 

exception of edit areas and menus. Examples include field labels in 

dialog boxes, message windows and worksheets. 

 Menus tab has settings you can apply to menus. 

 Read From Here tab has settings you can apply to this Dolphin 

ScreenReader continuous reading mode. 
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 Dolphin Cursor tab has settings you can apply to this Dolphin 

ScreenReader screen reviewing mode.  

Settings: 

 Punctuation Level list. 

Dolphin ScreenReader groups punctuation characters into specific 

categories. You can change how much punctuation is announced by 

Dolphin ScreenReader by changing the punctuation level. 

 Number Announcement group. 

You can read numbers as digits, pairs or words. If you select "Digits" 

then Dolphin ScreenReader will spell each number, for example, one, 

two, three, four. If you select "Pairs" then Dolphin ScreenReader will 

read numbers as a two digit value, for example, twelve, twenty three. 

If you select "Words" then Dolphin ScreenReader will read numbers in 

full, for example, one thousand, two hundred and twenty three. 

 Announce group 

Blank lines check box. 

You can have Dolphin ScreenReader tell you when the focus is on a 

blank line by selecting this check box. This option applies specifically 

to edit areas. 

Capitals check box. 

You can have Dolphin ScreenReader tell you when a capital letter is 

being used by selecting this check box. You choose how Dolphin 

ScreenReader indicates capitals by choosing settings in the "Voice 

Preferences" dialog box and "General Announcements" dialog box. 

Repeats check box. 

You can change how Dolphin ScreenReader reads repeating 

characters by selecting this check box. This applies to punctuation 

characters and symbols and excludes letters and numbers. You 

control the method Dolphin ScreenReader uses to indicate repeated 

characters by choosing settings in the "Repeats" dialog box. 

Colour change check box. 

You can have Dolphin ScreenReader tell you about changes in the 

font colour by selecting this check box. 
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Back colour change check box. 

You can have Dolphin ScreenReader tell you about changes in the 

background colour by selecting this check box. 

Point size change check box. 

You can have Dolphin ScreenReader tell you about changes in the 

font size by selecting this check box. 

Font change check box. 

You can have Dolphin ScreenReader tell you about changes in the 

font type by selecting this check box. 

Selected check box. 

You can have Dolphin ScreenReader tell you about selection 

changes by selecting this check box. For example, if you select one 

word in a line of text and then press the Read Line hot key, Dolphin 

ScreenReader will announce the selection change. 

Links check box. 

You can have Dolphin ScreenReader tell you when links are part of 

the text you are reading by selecting this check box. Note, this option 

does not apply to web pages. To change the announcement of links 

on web pages requires changes to your verbosity scheme. 

Meaning change check box. 

You can have Dolphin ScreenReader tell you when text is marked as 

an abbreviation, acronym, citation, emphasis, shortquote, strong and 

monospace by selecting this check box. This option applies to HTML 

content. 

Underline change check box. 

You can have Dolphin ScreenReader tell you when text is underlined 

by selecting this check box. 

Weight change check box. 

You can have Dolphin ScreenReader tell you when text is bold by 

selecting this check box. 

Italics change check box. 

You can have Dolphin ScreenReader tell you when text is italic by 

selecting this check box. 

Strikethrough change check box. 

You can have Dolphin ScreenReader tell you when text is 

strikethrough by selecting this check box. 
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Spelling Error check box. 

You can have Dolphin ScreenReader tell you when text is marked as 

a spelling error by selecting this check box. This option applies to 

Microsoft Office and requires you to be showing errors in your 

document by using Office's wavy underline option. 

Grammar Error check box. 

You can have Dolphin ScreenReader tell you when text is marked as 

a grammar error by selecting this check box. This option applies to 

Microsoft Office and requires you to be showing errors in your 

document by using Office's wavy underline option. 

Script change check box. 

You can have Dolphin ScreenReader tell you when text is subscript 

or superscript by selecting this check box. 

Heading change check box. 

You can have Dolphin ScreenReader tell you when a heading style 

change occurs by selecting this check box. 

Text Effect change check box. 

You can have Dolphin ScreenReader tell you about a text effect 

change by selecting this check box. A text effect is a character 

attribute like emboss, shadow or engrave. 

Text Animation change check box. 

You can have Dolphin ScreenReader tell you about a text animation 

change by selecting this check box. A text animation is a character 

attribute like "Blinking Background", "Las Vegas Lights" and 

"Marching Red Ants". This option applies to Microsoft Office. 
  

18.16  Speech General Announcements dialog box 

Menu: Speech > General Announcements 

You can specify settings for a variety of Dolphin ScreenReader features by 

selecting options in the "General Announcements" dialog box. The 

availability of some options depends on the synthesiser you are using. 
  

 Announce Braille changes check box. 

You can announce the changes you are making to Braille settings 

when you are using hot keys by selecting this check box. This 

includes turning on Braille output, turning on Literary Braille, turning 
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on Physical Braille, turning on Enhanced Braille and  your Routing 

button actions. 
  

 Announce 'no focus detected' check box. 

You can have Dolphin ScreenReader announce when an application 

loses focus by selecting this check box. An example when an 

application might lose focus is when closing a foreground window fails 

to place the focus in the background window. You can usually resolve 

this loss of focus by pressing ALT + TAB to switch to an open 

application or by pressing WINDOWS KEY + D to place focus on the 

Desktop. 
  

 Announce text under mouse check box. 

You can have Dolphin ScreenReader read the text under the mouse 

pointer by selecting this check box. To read the text requires you to 

move the mouse pointer to the place where the text is on the screen. 
  

 Announce clipboard actions check box. 

You can have Dolphin ScreenReader announce the results of your cut, 

copy and paste key commands by selecting this check box. Dolphin 

ScreenReader bases the clipboard announcements on the use of 

CONTROL + C to copy, CONTROL + X to cut and CONTROL + V to 

paste. If you use different keyboard commands then use the options 

in the "Clipboard key mapping" dialog box to define alternative key 

presses. 
  

 Announce line count when selecting text check box. 

You can count the number of lines you are selecting by selecting this 

check box. Note that this option is only available in areas with a 

supporting Document Object Model (DOM) like NotePad, WordPad 

and Microsoft Word. 
  

 Announce capitals when reading lines check box. 

You can include capital announcements when you read a line of text 

by selecting this check box. You are reading a line of text when you 

are moving focus to a new line, for example, by using keys like UP 

ARROW, DOWN ARROW, PAGE UP and PAGE DOWN. 
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Note: To turn on capital announcement you must select the "Capitals" 

check box in the "Edit Areas" tab of the "Text Style Announcements" 

dialog box. 
  

 Use Beeps for Capital Announcement check box. 

By default, Dolphin ScreenReader will describe capital letters by using 

words. Using words is a method all synthesisers support. However, it 

is also possible with some synthesisers to indicate capitals with a 

sound. If this option is available, you can use beeps to indicate 

capitals by selecting this check box. 
  

 Uses sound list. 

If you select the "Use Beeps for Capital Announcement" check box 

then you can choose the sound you would like to use to indicate 

capitals from this preset list. 
  

 Repeats button. 

You can open the "Repeats" dialog box by selecting this button. The 

"Repeats" dialog box lets you control how Dolphin ScreenReader 

reads repeating characters. 
  

 Clipboard key mapping button. 

You can open the "Clipboard key mapping" dialog box by selecting 

this button. The "Clipboard key mapping" dialog box lets you define 

what keys Windows uses for cut, copy and paste commands. 
  

18.17  Speech Advanced Options dialog box 

Menu: Speech > Advanced Options 

You can specify settings for a variety of Dolphin ScreenReader features by 

selecting options in the "Speech Advanced Options" dialog box. 
  

Cursor tab. 

 Use Dolphin Cursor automatically check box. 

This setting lets you turn the automatic Dolphin Cursor on or off. 

The automatic Dolphin Cursor is a special feature that may be 

programmed in as part of a Map file. The Map file can set areas to 
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automatically use the Dolphin Cursor when the keyboard focus moves 

to certain parts of your application. This is useful when no application 

focus exists in the designated window. 

You can turn on and off the automatic Dolphin Cursor behaviour with 

a hot key. To toggle automatic Dolphin Cursor on and off press LEFT 

CONTROL + 4. 

 Restrict Dolphin Cursor to current area CHECK BOX. 

The Dolphin Cursor can be restricted in its movement so that it cannot 

move outside the current area. This behaviour is set in a Map file. 

This check box determines whether the Dolphin Cursor should be 

restricted to the current area or not. 

You can use a hot key to turn on and off this restriction. To toggle this 

option on and off press LEFT CONTROL + 2. Note that this setting will 

only become active the next time you turn the Dolphin Cursor on. 

 Auto Forms Mode check box. 

When this check box is selected you will be automatically switched 

into Forms Mode when you TAB onto an input Field. This enables you 

to fill in forms more easily using the Dolphin Cursor. A hot key can 

also be used to toggle this feature. Press CAPS LOCK + ENTER to 

toggle automatic Forms Mode on and off. 
  

Verbosity tab. 

Dolphin ScreenReader comes with a number of default Verbosity Schemes. 

A Verbosity Scheme controls what Dolphin ScreenReader tells you about 

the current control type, like a button or check box. In this property sheet 

you can modify an existing Verbosity Scheme or even create your own 

custom schemes. 

You can learn more about modifying or creating your own verbosity 

schemes by visiting the Tutorial pages on the Dolphin web site. 
  

Monitor Markers tab. 

Monitor Markers monitor certain areas of the screen for change. When a 

change occurs then the Monitor Marker will perform a designated action. 

The Monitor Marker and action are set in a Map file. Where a monitor 
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marker has been implemented within a map then this should be explained 

in the accompanying support documentation. 

The "Monitor Markers" property sheet can be used to switch individual 

Monitor Markers on or off. 

 Set of markers list box. 

Use this pull down list box to choose a set of Monitor Markers to be 

listed below. You can either list all Monitor Markers for areas that are 

currently displayed on the screen, or a list of Monitor Markers for all 

currently running applications or you can choose to list all the Monitor 

Markers for a specific map file.  

 Marker Action list view. 

This list shows all the Monitor Markers in the selected set. Use the 

check boxes in front of each list item to switch the Monitor Marker on 

or off. 

A hot key can also be used to turn on and off all Monitor Markers. To 

do this press LEFT CONTROL + 5. 
  

18.18  Braille General Preferences dialog box 

Menu: Braille > General Preferences 

You can change various Braille settings in the "General Preferences" dialog 

box. 
  

Translation Tables tab. 

 Unicode to Braille Conversion list box. 

Choose from this list the Computer Braille table Dolphin 

ScreenReader uses to translate text to Braille. The language you 

select is used for both Computer Braille output and Computer Braille 

input. Computer Braille strictly uses one Braille cell per character, 

whatever that character is. It is of most use in applications where 

every character is of importance, you need to distinguish each 

possible character and space is not at a premium.  

 Unicode to Literary Braille Conversion list box. 

Choose from this list the Literary Braille table Dolphin ScreenReader 



 

Reference 153 

 

uses to translate text to Braille. The language you select only applies 

to Literary Braille output. The term Literary Braille covers both grade 1 

and grade 2 Braille tables. Literary Braille is of most benefit when 

reading ordinary text 

 Literary Braille Input list box. 

Choose from this list the Literary Braille table Dolphin ScreenReader 

uses to convert Braille input to text. The language you select only 

applies to Literary Braille input. When you use Literary Braille input, 

you use 6 dots and use uncontracted or contracted Braille (depending 

on the chosen input language).  Please note that the Braille 

characters you type will only appear in your document when you 

press the Braille Space key, or another key which is not a combination 

of Braille dots. 
  

Braille device tab. 

 Select Braille display button. 

Choose this button to open the "Select Braille display" dialog box. This 

dialog box lists all Braille devices detected by Dolphin ScreenReader. 

If no options are in the list then this means there are no configured 

devices to choose from. Check that your Braille display is configured 

correctly and make sure it is detected by Dolphin SAM. This is done 

by choosing "SAM Setup" in the "General Advanced Options" dialog 

box. 

 Configure button. 

The configure button will open the Driver Configuration dialog box for 

the Braille display currently in use. 

 Scroll Margin spin box. 

The Scroll Margin determines the amount the Braille display will move 

when you press the Read Back or Read forward keys. It is also used 

to scroll the display when a cursor moves beyond the left or right 

edges of the display. 
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18.19  Braille General Announcements dialog box 

Menu: Braille > General Announcements 

 Braille Changes group. 

Select the Dolphin ScreenReader changes to be output to your Braille 

display. 

 Delimiters group. 

These two lists allow you to place various shaped Braille characters 

around different types of objects in Physical Mode. Choose the type of 

object from the first list then the characters to use to mark that object 

from the second. 
  

18.20  Braille Input menu and dialog box 

Braille menu > Input 

The Input menu allows you to change the options for the braille input. 

Braille Input controls the action that the braille routing buttons perform. In 

addition certain braille displays allow "Braille Key Input", i.e. using the keys 

on the braille display for typing text.  
  

 Braille keys item. 

This option allows you to type characters by using six or eight buttons 

on your Braille Display.  The buttons you use to type depend on your 

display, and not all displays have this capability. Six key input can be 

useful if you wish to type without removing your hands from the Braille 

display. Computer code is used for this type of input. 
  

 Literary Input item. 

This option allows you to type characters by using six or eight buttons 

on your Braille Display.  The buttons you use to type depend on your 

display, and not all displays have this capability. It is also restricted to 

supported Braille tables. 
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18.20.1  Routing Buttons 

The "Input from Display" dialog box allows you to set what the routing 

buttons do on your Braille display and select whether the Braille Input Mode 

is on. 
  

 Routing Button Action group. 

These radio buttons determine what happens when you press a 

routing button on your Braille display. The choices are to perform a 

left mouse click, double click, right click or describe the character at 

that point. 
  

 Second Routing Button Action group. 

These radio buttons determine what happens when you press a 

secondary routing button on your Braille display. The options are to 

perform a left mouse click, double click, right click or to describe the 

character at that point. Not all Braille displays have a second row of 

routing buttons. 
  

18.20.2  Dolphin Cursor Options 

The "Input from Display in Dolphin Cursor Mode" dialog box allows you to 

set what the routing buttons do on your Braille display when using the 

Dolphin Cursor. 
  

18.21  Characters 

Braille menu > Characters 

The Characters menu allows you to change various Braille settings to do 

with how characters are shown on the Braille display. This includes the 

Literary Braille Mode and Enhanced Display Mode. 
  

 Literary item. 

 This setting turns the Literary Braille option on or off.  If you turn this 

on, your Braille display will show the Braille in literary Braille, 

otherwise it will use Computer Braille. We use the term "Literary 

Braille" as it covers both grade 1 and grade 2 Braille. 
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 Enhanced item. 

Use this setting to turn the Enhanced Braille feature on or off. When 

on, any characters which have an attribute other than "normal" will be 

marked, usually by adding a dot 8. 
  

18.21.1  Options 

Characters dialog box. 

The Characters dialog box allows you to change various Braille settings to 

do with how characters are shown on the Braille display. This includes the 

Literary Braille Mode and Enhanced Display Mode. 

Options: 
  

 Cursor Word Contracted check box. 

When in Literary Mode you can choose to have the word containing 

the cursor contracted or uncontracted. This check box toggles this 

setting. If this option is turned off, the word containing the cursor will 

be written using Computer Braille. Having the cursor word 

uncontracted may make editing documents easier. 
  

 Show Capitals check box. 

Some versions of Literary Braille denote capital letters by prefixing the 

letter or contraction with a special sign called a Capital Sign. Other 

versions of Literary Braille permit the omission of any such notation, 

thus saving space. 
  

 8-dot Braille check box. 

The ‘8 Dot Braille check box’ toggles between using eight-dot or 

six-dot Braille. This is mainly useful when using Computer Braille, 

where, for example, the lower two dots can be used to show capital 

letters and other special symbols. For example, in several Computer 

Codes, capital letters are denoted by adding a dot 7 to the regular 

Braille symbol for the letter. You may prefer to use six-dot Braille if 

you have difficulty reading the eight-dot version. 
  

 Tremble Capitals check box. 

This option, which is particularly useful when in six-dot Braille, makes 
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capital letters on your Braille display blink. The blink rate of any such 

characters is governed by the Blink Rate setting in the Cursor Dialog 

Box. 
  

 Enhanced group. 

The Enhanced Characters options determine what exactly constitutes 

an "Enhanced" character. Select those attributes you want to be 

shown. 

 Style list. 

Style allows you to select how the enhanced characters are shown. 

By default dot 8 is added to the character. Other options include dot 7 

and dot 7 and 8.  
  

18.22  Braille Layout menu and dialog box 

Braille menu > Layout 

The options in this menu allow you to configure the Layout of the Braille 

display. 
  

 Physical Mode item. 

This option switches between Physical Mode and Logical Mode. 

Physical mode provides the opportunity to determine the physical 

layout of objects on the screen.  Logical mode shows the logical 

association of any incidental text with the focus. This is similar to the 

speech output. This mode is particularly useful for working with dialog 

boxes, as the screen reader will associate the text labels in a dialog 

box with their corresponding controls. 
  

 Tracking item. 

This check box determines whether the Braille display follows the 

movement of the focus in Physical Mode as you use your application. 

Normally, you would have Tracking turned on, but you might want to 

turn it off, for example, when you want to monitor a certain region on 

the screen. 
  

18.22.1  Options 

Layout dialog box. 
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The options in this dialog allow you to configure the Physical Mode of the 

Braille display.  They include options such as whether lines of text are 

wrapped as you navigate forward and back, whether start and end of line 

markers are shown and whether the physical layout of the screen is 

displayed. 
  

 Forward and Back Wrapping check box. 

This check box sets whether the Read Forward and Read Back keys 

will move through the lines on the screen when in Physical Mode. If 

this option is turned off, these two hot keys are limited to the current 

line. However, if wrapping is turned on, you will be able to read 

through the whole window by using just the Read Back and Read 

Forward keys. 
  

 Show complete words only check box. 

Typically, lines of text on the screen are longer than the length of 

Braille displays, meaning that a Braille display can only show a portion 

of a line at a time. To see the next portion, you press the Braille Move 

Forward key. This can result in words being split over the end and 

beginning of the Braille display as you move forward. 

Selecting "Show Complete Words Only" will prevent words being 

truncated because they do not fit on the Braille display. This is 

especially helpful if you use contracted Braille codes such as UK 

Grade 2 Braille. This option means the scroll margin position is 

adjusted based on the positions of words. 

If you move forward but the next word does not fit on the Braille 

display then a gap will be shown after the last character in the last 

word on the display. This makes it easier for you to click beyond the 

end of the last word shown. It also gives more of a clue that this is the 

end of the word. 

When there are multiple spaces or gaps that span multiple Braille 

cells, it may be the case that when moving forward or back that the 

text does not begin in the extreme left hand cell. 

Where the word exceeds the total number of Braille cells then the 

word will appear truncated on the Braille display, that is, it will behave 

as if "Show Complete Words Only" is unselected. It is also possible 

that large amounts of the display can appear blank. 
  

 Start and End Marker check boxes. 

These two check boxes determine whether there is a marker symbol 
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placed at the start and end of lines of text when in Physical Mode. 

This can be useful when Wrapping is on and you wish to know when 

you move from one line to another. 
  

 Show Layout check box. 

This check box turns the Layout option on and off for Physical Mode. 

With Layout on, the characters on the line are placed on the Braille 

display as closely as possible to their screen layout. This may result in 

some compression or expansion. If Layout is turned off, the Braille 

display will just show the characters and the gaps (for example 

between columns), but the layout may not correspond exactly to the 

screen layout. 
  

 Expand Gaps check box. 

When Show Layout is turned off, this setting determines whether gaps 

in a line of text are shown on the Braille display. 
  

 Pixels per Cell in Gaps list. 

With Show Layout turned off, this option determines how many Braille 

cells should be used for gaps in lines of text. 
  

 Layout methods check boxes. 

The Phrases, Words and Characters check boxes determine the way 

the characters are positioned on your Braille display in Physical Mode 

when Show Layout is turned on.  Each item (a phrase, word or 

character) is positioned in the cells that it occupies. 
  

 Expand into Gaps check box. 

This check box allows a set of characters to flow into the gap that 

follows it, if Show Layout is turned on. This may result in slightly less 

compression of the characters being necessary, but the gaps between, 

say, two columns of text, will not be the correct width. 
  

 Display Dashes check box. 

In Physical Mode, with Show Layout turned on, if any expansion is 

necessary, the extra space the text should occupy will be filled with 

dashes. This check box determines whether these dashes are shown 

or not. 
  

 Layout Length list. 

The Layout Length is the number of Braille cells to distribute across 
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the entire width of the screen. The amount of space one Braille cell 

represents is the total screen resolution divided by this number. 

For example, if you had an 800-pixel screen resolution, and a Layout 

Length of 80, each cell on the Braille display would represent 10 

pixels. 
  

18.23  Braille Status Cells dialog box 

Menu: Braille > Status Cells 

The "Status Cells" dialog box sets what is to be shown on your Braille 

display Status Cells. 

Select the items you want displayed. Each option takes one cell. 
  

 Features on Display check box. 

This status cell shows the current setting of various modes of the 

Braille system, including the Attribute Modes, Literary Braille, Physical 

Mode and Tracking. 

The top four dots show which of the Attribute modes is active: If this is 

blank, the display is showing characters (normal). Letters A to E 

represent the five attribute displays available using the Cycle 

Attributes key. Letter F represents the Describe Character mode. 

The lower four dots show other settings, as follows: 

- Dot 3: Raised if in Literary Braille, otherwise Computer Braille. 

- Dot 6: Raised in Physical Mode, otherwise Logical Mode. 

- Dot 7: Raised if the display currently shows the focus. 

- Dot 8: Raised if Tracking is on. 
  

 Cursor Position check box. 

This status cell shows the position of the cursor along a line of text 

when in an edit area.  

The upper four dots represent the tens and the lower four dots show 

the units. For example dots 245678 show that the cursor is at position 

0 (the extreme left).  Please note that the number of characters 

which will fit on a line depends on the font size and size of the 

window. 
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 Focus Type check box. 

This status cell indicates the type and state of the focus control. This 

is particularly useful in Physical Mode. 
  

 Attributes check box. 

The various Attribute check boxes display the attributes of the 

character under the cursor in an edit area. The information is exactly 

the same as for the Attribute Modes function. 
  

18.24  Braille Cursor menu and dialog box 

Braille menu > Cursor 

The Cursor menu allows you to change how the cursor appears on the 

Braille display. Most of these settings only apply when editing text in an edit 

area. 

Options: 

 Visible item. 

This setting determines whether the cursor is shown on the Braille 

display. In an edit area, the Braille cursor is a single cell, which 

appears superimposed on the character at the insertion point. 

When not in an edit area and the Braille display is set to Physical 

Mode, the "cursor" is taken to be the current focus. All the characters 

in the focus are underlined with dots 78. 
  

18.24.1  Style 

The "Cursor Style" dialog determines the appearance of the cursor. The 

settings include the shape and blink rate to be used to indicate the cursor 

position and the style to be used when in physical Braille mode. 

  Shape list. 

This pull down list box determines the shape of the cursor when in an 

edit area. Available options include: Dot 8; Dots 7 and 8; All Dots; 

Blinking Dot 8; Blinking Dots 7 and 8; Blinking All Dots. 
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The cursor is superimposed on the current character. Thus, the larger 

the cursor, the easier it is to find, but the harder it is to read the 

character under it. 

 Blink rate list. 

The Blink Rate listbox sets the speed of the blinking cursor and any 

blinking text on your Braille display.  The higher the number, the 

faster the blink rate. 

 Physical Focus Style list. 

The "Physical Focus Style" pull down list box allows you to select how 

Dolphin ScreenReader indicates the position of the focus when you 

are in physical braille mode. Available options include: Dot 8; Dots 7 

and 8; Dot 7; Blinking Dot 8; Blinking Dots 7 and 8; Blinking Dot 7. 
  

18.25  Braille Advanced Options dialog box 

Menu: Braille > Advanced Options 

You can specify settings for a variety of Dolphin ScreenReader features by 

selecting options in the "Braille Advanced Options" dialog box. 
  

On screen Braille tab. 

You set the size and position of the window for the "Show Braille On 

Screen" option here. 

This small window mirrors the content of the Braille display. 
  

18.25.1  Verbosity tab (Braille) 

Verbosity tab. 

Dolphin ScreenReader comes with a number of default Verbosity Schemes. 

A Verbosity Scheme controls what Dolphin ScreenReader tells you about 

the current control type, like a button or check box. In this property sheet 
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you can modify an existing Verbosity Scheme or even create your own 

custom schemes. 

You can learn more about modifying or creating your own Verbosity 

Schemes by visiting the Tutorial pages on the Dolphin web site. 
  

18.25.2  Hooked Areas tab (Braille) 

Hooked Areas tab. 

Braille Hooked Areas can monitor certain areas of the screen and output 

this data to the Braille display. A Braille Hooked Area is set in a Map file 

and is commonly configured for bespoke applications like Telephony 

programs. Where a Braille Hooked Area has been implemented within a 

map then this should be explained in the accompanying support 

documentation. 

The "Hooked Areas" property sheet can be used to switch individual Braille 

Hooked Areas on or off. 

 Set of Hooked Areas list box 

Use this pull down list box to choose a set of Hooked Areas to be 

listed below. You can either list all areas currently displayed on the 

screen or available in the currently running applications. 

 Braille Hook Action list view. 

This list shows all the Hooked Areas in the selected set. Use the 

check boxes in front of each list item to turn the Hooked Area on or off. 

A hot key can also be used to turn on and off all Braille Hooked Areas. 

To do this press LEFT CONTROL + LEFT SHIFT + 2. 
  

18.26  Media Scan and Read Settings dialog box 

Menu: Media > Scan and Read > Scan and Read Settings 

The "Scan and Read Settings" dialog box contains options you can use to 

change how Dolphin ScreenReader saves and converts scanned 

documents. 
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Options. 

 Scanner list. 

The "Scanner" list shows the list of scanners available on the 

computer. You must ensure the selected scanner matches the 

scanner you are using with Dolphin ScreenReader. 

 Language list. 

The "Language" list refers to the language of the text you are 

scanning. If you are scanning text in a foreign language then, for best 

results, you must ensure this setting matches the language of the text 

being scanned. 

 Colour list. 

The "Colour" list allows you to change the colour setting for the 

scanner. For best results, ensure the value as closely matches the 

print colour being scanned, for example, if you are scanning a plain 

letter then using "Black and white" will bring the most accurate 

recognition. 

 Paper list. 

The "Paper" list relates to the size of paper you are scanning. For best 

results, ensure the paper size matches the size you are scanning. 

 Scan and Read Output Folder box. 

This edit box states the location where Dolphin ScreenReader saves 

the converted documents. Use the browse button to change the folder 

location. 
  

18.27  General Startup Preferences dialog box 

Menu: General > Startup Preferences 

You can specify settings for a variety of Dolphin ScreenReader features by 

selecting options in the "Startup Preferences" dialog box. The availability of 

some options depends on the synthesiser you are using and whether you 

are running a local, network or USB edition of Dolphin ScreenReader. 

Options 
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 Launch Dolphin ScreenReader after logon check box. 

You can set your computer to automatically run Dolphin 

ScreenReader after you log into your user account by selecting this 

check box. 
  

 Disable splash screen at startup check box. 

You can stop the Dolphin ScreenReader splash screen showing by 

selecting this check box. A splash screen is an image that appears 

while a computer program is loading. 
  

18.27.1  Disable sounds at startup 

 Disable sounds at startup check box. 

Enabling this check box stops Dolphin ScreenReader from playing a 

startup sound every 5 seconds until it finishes loading (so that you 

know the program is still loading). 
  

 Announce when loaded check box. 

You can announce "Dolphin ScreenReader loaded" when Dolphin 

ScreenReader finishes loading by selecting this check box. 
  

 Load all SAM drivers at startup check box. 

You can have SAM check for all supporting devices each time it starts 

by selecting this check box. Note that this can make the launching of 

Dolphin ScreenReader slower because it waits for SAM to complete 

its detection process. You should only select this check box if you are 

regularly changing your output devices. 
  

 Always save user settings check box. 

By default, Dolphin ScreenReader will automatically save changes 

you make to Dolphin ScreenReader settings. You can prevent this 

behaviour by deselecting the "Always save user settings" check box. 

When this check box is unselected then you must manually save the 

changes you make. You can do this by selecting the "Save Settings" 

option in the "File" menu. 

  
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 Ask user check box. 

The "Ask user" check box becomes available when you deselect the 

"Always save user settings" check box. If you select the "Ask user" 

check box, then Dolphin ScreenReader will ask you if you want to 

save the changes you have made when you quit Dolphin 

ScreenReader. 
  

Braille at user logon check box. 

You can add Braille support to the Windows Logon Screen by selecting this 

check box. To successfully use a Braille display at the user logon screen 

requires you to initially configure Dolphin ScreenReader to detect the 

display. 
  

 Voice at user logon check box. 

You can add speech support to the Windows Logon Screen by 

selecting this check box. After selecting this check box, at the 

Windows Logon Screen you can use the following hot keys to control 

speech: 

Press F1 to announce the available hot keys. 

Press F2 to mute the voice. 

Press F3 to repeat the last speech output. 

Note: Speech at the Windows Logon Screen is only possible by 

having a Dolphin ScreenReader component running as a Windows 

service. You cannot run a full program at the Windows logon screen 

because of Windows security restrictions. 
  

18.28  General Update Settings dialog box 

Menu: General > Update Settings 

The "Update Settings" dialog box sets when Dolphin ScreenReader 

automatically checks for updates. Dolphin ScreenReader can check daily, 

weekly, monthly or never. 

You can also keep Dolphin ScreenReader up-to-date by selecting "Check 

for Updates" from the "Help" menu. 
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18.29  General Control Panel dialog box 

Menu: General > Control Panel 

The "Control Panel" dialog box contains global settings to control the 

Dolphin ScreenReader user interface. 
  

 Access System Language list. 

This list box lets you change the Dolphin ScreenReader system 

language. This includes all of the text in the Dolphin ScreenReader 

control panel, synthesiser output language and help files. 
  

 Enable helpful warnings check box 

This checkbox switches the helpful warnings on or off. An example for 

a helpful warning is the graphics training: If you press the hot key for 

graphic training but graphic training is switched off you can get a 

warning. 
  

 Enable help messages check box. 

Help messages can appear to guide you through specific tasks.  If 

this option is unselected then these messages will not appear.  It is 

also possible to disable specific help messages when they appear by 

unselecting the "Do not show this message again" check box within 

the message window itself. 
  

 Use Default Settings in the control panel check box. 

By default, you will use the current Dolphin ScreenReader settings 

when going through the Dolphin ScreenReader control panel. This 

lets you experience the effects of change to settings as they happen. 

In some cases, settings you wish to use in your application may not 

be suitable for the Dolphin ScreenReader control panel. Selecting this 

check box means Dolphin ScreenReader will switch to use the Default 

Application settings and not your custom Application Settings. 
  

 Hide when minimised check box. 

You can prevent the Dolphin ScreenReader control panel being on 

the Taskbar and part of the "Switch To" dialog box by selecting this 

check box. 

You can continue to access the Dolphin ScreenReader control panel 

with the "Open control panel" hot key or through the System Tray. 
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 Menu bar and Button Bar Style radio buttons. 

You can show the Dolphin ScreenReader control panel only as a 

menu bar or as a menu bar and button bar. The Button Bar Style 

includes large graphical buttons which offer easy access to the main 

Dolphin ScreenReader settings. 
  

 Status bar check box. 

You can hide the status bar that is part of the Dolphin ScreenReader 

control panel by deselecting this check box. 

The status bar contains information about the application and the 

current settings file in use. All changes you make in the control panel 

apply to this settings file. 
  

 Always on top check box. 

If this setting is enabled then the Dolphin ScreenReader control panel 

will always be on top of other windows.  
  

 Start with panel ... radio buttons. 

You can control the appearance of the Dolphin ScreenReader control 

panel when Dolphin ScreenReader starts. You can set the control 

panel to be showing, minimised or at the same position when you last 

closed Dolphin ScreenReader. 
  

18.29.1  Control Panel Theme 

 Control Panel Theme list. 

This list box lets you change the colours displayed in Dolphin 

ScreenReader’s control panel by allowing you to select one of a 

number of pre-defined colour schemes. The default setting is "System 

Colours", which makes Dolphin ScreenReader use the colours of your 

currently chosen Windows colour scheme. 
  

18.30  General Keyboard dialog box 

Menu: General > Keyboard and Hot Keys > Keyboard 

You can specify what keyboard layout and hot key set you want to use in 

the "Keyboard" dialog box. 
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Options: 

 Keyboard list. 

The "Keyboard" list box sets the keyboard type. This does not have to 

be a true reflection of the keyboard you are using. 

 Language list. 

The "Language" list box should match your Windows keyboard layout. 

The value relates to Keyboard Announcements and hot key 

assignments. 

 Set list. 

The "Set" list box specifies the hot key set to be used. The sets 

available will be restricted by the selections in the "Keyboard" list and 

"Language" list. 

 Restore default hot keys button. 

You can restore any changes you may have made to a hot key set by 

selecting this button. 

 Num Lock On enables Number Pad keys check box. 

You can enter numbers using your keyboard's Number Pad by 

selecting this check box. If you do select this option then turn the Num 

Lock Off to use Dolphin ScreenReader hot keys that use the Number 

Pad. 
  

18.31  General Hot Keys dialog box 

Menu: General > Keyboard and Hot Keys > Hot Keys 

 You can add, replace or remove any hot key assignments to Dolphin 

ScreenReader commands by using options in the "Hot Keys" dialog box. 

Note that the list of commands are global commands. Hot keys defined in 

Scripts and Maps cannot be changed using this dialog box. 

To learn more about modifying hot keys, see the "Resolve Hot Key 

Conflicts" topics in this user guide. 
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18.32  General Web Settings dialog box 

Menu: General > Web Page Settings 

You can change how Dolphin ScreenReader interacts with a web page by 

changing web page settings. The settings you choose can apply to a single 

web page, a web site or to all web pages. 
  

 General settings. 

You can set how Dolphin ScreenReader detects elements on a web 

page by changing "General" settings. For example, the detection of a 

table can be disabled by deselecting the "Announce tables ..." check 

boxes. 
  

18.33  General Advanced Options dialog box 

Menu: General > Advanced Options 

You can specify settings for a variety of Dolphin ScreenReader features by 

selecting options in the "General Advanced Options" dialog box. 
  

System Configuration tab 
  

 Windows Settings button. 

Dolphin ScreenReader makes some changes to your system to 

ensure best accessibility. You can disable any of the changes made 

by selecting this button to open the "Windows Settings" dialog box 

and deselecting any listed item. 
  

 SAM Setup button. 

You access the "Configure SAM" dialog box by selecting this button. 

SAM allows you to turn on or turn off the detection of speech and 

Braille devices and to configure the SAM driver for each device. 

 Close SAM on exit check box. 

Dolphin SAM is a separate component of Dolphin ScreenReader. You 

can quit Dolphin SAM when you quit Dolphin ScreenReader by 

selecting this check box. 
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Detection Settings tab 
  

 

 Actions button. 

This button will open the "Action list" dialog box. The Action List dialog 

box lets you adjust the global actions. You can also edit and delete 

actions. For more information please refer to the Mapping Guide 

support documentation. 

 Graphic Objects button. 

This button will open the "Graphics Database" dialog box. This dialog 

box lists any graphics that you have manually trained. You can edit 

and delete graphics from this dialog box. 
  

 Allow remote mapping check box. 

You can enable remote mapping by selecting this check box. This 

allows computers running the Dolphin remote training utility to connect 

to your computer. 

For security reasons, if you enable this option it will be automatically 

turned off when you quit Dolphin ScreenReader. 

 Read in columns if present check box. 

You can organise the screen into columns based on Dolphin 

ScreenReader's internal detection system by selecting this check box. 

This influences the reading options in Dolphin ScreenReader in areas 

with no Document Object Model (DOM). 
  

18.34  Item Finder dialog box 

Menu: General > Item Finder 

You can use the Item Finder to list certain objects in an application window. 

You can then select the objects and perform actions upon them. Examples 

include clicking a link on a web page or moving to a heading in a 

document. 

You can use the item finder in programs like Microsoft Office and Internet 

Explorer. 
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If you are in an application that does not support the Item Finder then the 

Item Finder is disabled. 

To learn more about the Item Finder and the support it offers for your 

application see the Dolphin ScreenReader Help available for your 

application. 
  

18.35  Braille Control Names 

The names for many of the controls that you will encounter in Windows 

have been abbreviated to save space on the Braille display.  

The following table lists the abbreviations used. 

Control Abbreviation 

Balloon bln 

Button btn 

Button bar btnbar 

Cell cel 

Check box (checked) Filled box 

Check box (partial checked) Partly filled box 

Check box (unchecked) Empty box 

Column col 

Console con 

Custom control ctl 

Dialog dlg 

Graphic bmp 

Group box grp 

Heading hdg 

Hypertext htxt 

Item itm 

Item (bulleted) blt 

Link lnk 

Link (visited) v lnk 

List box lbx 

List view lv 
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Menu mnu 

Menu bar mnubar 

Object obj 

Property sheet prsh 

Radio button (checked) Filled circle 

Radio button (unchecked) Partial circle 

Scroll bar scrl 

Spin control spn 

Status bar stat 

Tab control tabctl 

Tab sheet tabsh 

Table tbl 

Title bar titl 

Toolbar tlbar 

Track bar trkbar 

Treeview tree 

Treeview check control tree chkbx 

Treeview radio tree radio 

Treeview radio control tree radio 

Window win 

Window (dialog) dlgwin 

The Braille verbosity schemes determine how much information is 

displayed on the Braille display.  For the Minimum and Low Verbosity 

Schemes, the various control types listed above will not be shown in Braille. 

You may customise verbosity schemes to suit. 

Notes: 

 Some area types, such as edit areas, are not normally shown on the 

Braille display.  A blinking cursor is shown instead.  You can change 

the way the cursor appears, see topic Cursor Style Options for details. 

 Some types of control are only shown if you use the Dolphin Cursor 

and navigate to them. 
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 You can also use the Status Cells on your Braille display to indicate 

Focus Types. This may be particularly useful if you want to use the 

Minimum or Low Braille Verbosity. 
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